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Overview 

Introduction 

ACD Report Server is an End User call management tool that provides: 

 Real-time Call Reporting 

 Cradle to Grave Reporting 

 Call Logging 

ACD Report Server is also an ideal tool for Dealers in monitoring and debugging the initial setup of the 

telephony environment. 

ACD Report Server supports integration with Panasonic TDA PBXs (KX-TDA 100, KX-TDA 200 and KX-

TDA 600) via CSTA interface. 

This section covers the following topics: 

 Who Can Use ACD Report Server? 

 ACD Report Server Key Features 

 ACD Report Server Benefits 

 ACD Report Server Architecture 

 General Features 

 Monitoring Features 

 Reporting Features 

Who Can Use the ACD Report Server? 

 Any IT personnel from both small and medium corporations 

 Any manager that is in charge with infrastructure costs management 

 Any Dealer involved in monitoring and debugging the setup of telephony environment   

ACD Report Server Key Features 

 Unique solution in the market that integrates with TDA Panasonic PBX series (KX-TDA 100, KX-TDA 

200, KX-TDA 600) via CSTA interface 

 Multi-Client/ Server architecture built under Windows OS  

 100% GUI monitoring and reporting features 

 Export reports in portable formats like PDF, Word, Excel, HTML, Lotus, CSV, TSV and XML 
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 E-mail reports to the desired recipients 

 Designed for 7-days and 24 hours availability 

 Monitor in real-time the ACD operational status of the PBX system by analyzing the tree view window 

with extensions and call status, and counters that are displayed on the screen lively 

ACD Report Server Benefits 

 Affordable solution and easy to use interface 

 Increase the efficiency of decision making process 

 Increase the organization flexibility and reduce the operational costs 

 Analyze the call traffic helping IT stuff identify different trends 

 Help the labor cost management 

 Identify frequently dialed numbers 

 Save costs by recognize either unused or faulty extension and CO lines 

 Assess telephone answer times for individuals and groups 

 Track incoming calls via caller ID information 

 Agent monitor by Agent ID 
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ACD Report Server Architecture 

ACD Report Server consists of the following components:  

 ACD Report Client (PC) 

 KX- NCV200 (ACD Report Server + Voice Processing System) 
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General Features 

ACD Groups Information 
ACD Report Server collects all the information about the ACD groups defined on TDA PBX. All the past call 

processing is done according to the information gathered from the TDA PBX.  

Extension Information 
ACD Report Server collects all the information about the Extensions defined on TDA PBX and their 

allocation to different ACD groups. All the past call processing is done according to the information gathered 

from the TDA PBX.  

Agent Information 
For each Agent an unique ID number can be defined. The Agent logs in the system using the ID number and 

a password. This feature allows you to exactly monitor Agent activity and efficiency. 

Customer Information 
The ACD Report Server allows user to manage the customer information associated with the associated 

Caller ID lines. 

The user can: 

 Add a new Customer and specific Caller ID and/or Caller Name for easy identification of incoming calls  

 Remove an existing Customer 

 Modify the Customer information (i.e. First, Middle, Last Name and Caller ID) 

Monitoring Features 

Real-time Call Information 
ACD Report Server presents the following information categories: 

 Status of each extension (idle, busy, etc.) 

 Type of the call (incoming, outgoing, internal) 

 The phone numbers for each party involved in the call 

ACD Report Server manages the following type of counters and timers: 

 Active Counters 

 Cumulative Counters 

 Peak Counters 

 Active Timers 

 Cumulative Timers 
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User has access to real-time counters and timers, such as: 

 Total Incoming Calls (Active Counter) – displays the total number of the incoming calls currently being 

handled by the system  

 Outgoing Calls (Active Counter) – displays the number of the outgoing calls currently being handled by 

the system 

 Waiting Calls (Active Counter) – displays the total number of calls (ACD and Non ACD) that are 

currently waiting 

 Lost ACD Calls (Cumulative Counter) – displays the total number of ACD Calls that have been lost 

since the beginning of the session 

 Total Incoming Calls (Cumulative Counter) - displays the total number of the incoming calls handled by 

the system since the beginning of the session 

 Call Duration (Active Timer) – displays the total time spent in the system from the moment the call 

entered until it exits the system 

 Call Time (Active Timer) – the duration of the call current state (the display name is according to the 

current call state) 

 Talk Time for ACD Call (Cumulative Timer) - the length of time the call was in conversation with Agents 

 Total Waiting Time for ACD Call (Cumulative Timer) - the length of time the call waited in the ACD 

Queue and rang at Agent 

 Talk Time for Outgoing Call (Cumulative Timer), and more. 
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Performance Graphs 
ACD Report Server presents real-time custom or predefined performance graphs based on the system 

counters. 

ACD Report Server allows the user to inspect the Extensions or the Agents, ACD Groups, and System. 

The user can customize each type of graph (e.g. chart type, chart title, fonts, colors). 

Call information storing and retrieval 
All information regarding the call traffic is stored into ACD Report Server Database.  

The user can inspect the log information. 

Reporting Features 

Call Traffic Activity  
ACD Report Server allows the user to easily view the traffic reports based on different criteria, such as: 

 Phone extensions 

 PBX line/ Dialed number 

 Call duration  

 Customer Name 

 Lost calls 

 Incoming calls for ACD 

 Queue time 

 Overflow calls 

 No Answered calls 

 Time range 

 Type of the call (incoming, outgoing, internal) 

 Agent ID 

Reports 
The user can View, Print and Drill down on Reports for in-depth analysis using different filter criteria. 

The reports can be exported in different portable formats like PDF, Word, Excel, HTML, Lotus, CSV, TSV 

and XML. 

On every report a personalized logo picture can be set. 
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Filter and export information 
ACD Report Server allows the user to select the desired information to be exported in CSV format for further 

call analysis using specialized wizard.  

Pre-defined Report Templates 
ACD Report Server comes with a set of pre-defined report templates for quick generation, as follows: 

 CO Call Report 

 System Report 

 Group Report 

 Agent Report 

 AgentID based Report 

The following attributes can be specified to instantiate the report template: 

 Advanced Filtering using specialized wizard 

 Fields to be included in the report 

 Date Range Selector 

 Report Format Selector 

 Paper Format 
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ACD Report Server Getting Started 

Introduction 

This section covers the following topics: 

 Important Notes 

 Knows issues and limitations 

 Host Requirements 

 ACD Report Server Initialize 

 Installation Procedure 

 Settings for ACD Report Server 

Important Notes 

 Install and uninstall ACD Report Client while running Windows logged-in with Administrator privileges. 

Please contact your IT Manager for more information. 

 On Windows XP Professional SP2, the ACD Report Client opens three TCP/IP ports: 135, 5238 and 

5239. The Windows Firewall is automatically configured accordingly by the ACD Client application 

installation process. 

 ACD Report Client uses the following TCP/IP ports: 135(epmap), 5238-5240. These ports must not be 

blocked by other applications that run on the same computer. 

 Multiple ACD Report Client can be installed in the company network using the same license provided 

 Recommendation (for the dealers): Regarding the PBX settings for Groups - Overflow No Answer. All 

the Groups with no Overflow destination should have Overflow Time = None. 

 The maximum number of Clients that can be connected simultaneously to the KX-NCV200(ACD Report 

Server) is 3. 

 When you change the PBX connected to the LAN, initialize all the data in the Client database of KX-

NCV200. Refer to the Installation Manual of Voice Processing System for the procedure. 

 The KX-NCV200 does not support doorphone. 

 Call information is accumulated in Server even though no Client is connecting to Server. When a Client 

connects to Server, the Client will receive all call information, which it has not received yet from Server. 

After the Client completes receiving the call information, its starting process will be finished. And the 

Client application will be ready for users to use. Due to this reason, at the following cases, it will take 

long time to start Client because there will be a lot of call information that Client has to receive. 

 When Client has not connected to Server for long time. 
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 When the large amount of calls is on PBX even though it has not been so long time since Client 

connected to Server last time. 

To make Client start faster, it is highly recommended that Client connects to Server often, or Client 

keeps connecting to Server during the term, which the amount of calls is large in of a day. 

 When a Client connects to Server, if the Client has not connected to Server for more than 2 days, the 

Client will receive call information which is older than last 2 days from Server even after the Client 

opens. Due to this mechanism, it takes time to receive all call information and display the entire call 

history or create reports with entire call information. So when NCV200 is used in the environment that a 

large amount of calls are, it is highly recommended that Client is connecting to Server all the time or 

Client connects to Server short periodically. 

Knows issues and limitations  

General 
 After configuring any settings regarding 3.Group, 4.Extension, 10. CO&Incoming Call on the PBX side 

close the TDA Maintenance Console and then press the Restart button from ACD Client Application for 

changes take effect. 

ACD Report Client Installation 
 There is no uninstalling option from Start | Programs | Panasonic, neither from Program 

Files\Panasonic\... The application can be uninstalled only from Start | Settings | Control Panel | 

Add/Remove Programs. 

Customer Data and Agents Data 
 The Agents Data defined inside the ACD Report Server and any changes performed on the Agents 

Data do not affect the Extension names defined in PBX. 

 When Agents’ names are modified, changes will not be updated in ACD tree until those Agents will log 

in using the new name. 

 The Agent Data can not be edited while the Agent logs in an extension. 

ACD Monitor 
 Only for TDA version 3.0, in case of a three party conference, when the initiator of the conference 

hangs up (the other parties are in the talking state) the call info is incomplete – the log for that call will 

be recorded until the initiator of the conference hangs up. 

 For timers, the threshold unit measure is seconds no matter of which Timers Format option is enabled. 

 The Busy Overflow is not counted as Overflow counter. 

 The call can not be monitored if its overflowed destination is an extension that does not belong to any 

groups. 
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 The call through DISA will be counted when it is received. 

Performance Graphs 
 Custom Performance Graphs titles are not changed according to the monitored item. The title can be 

changed at step 5 of the wizard or double click an existing graph and change the title from Graph Title 

in the Other tab. 

ACD Reports 
 The Print window from Report Viewer doesn’t allow selecting the printer. 

 The Report Viewer window is modal (you cannot switch to ACD Report Client main window before the 

Report Viewer is closed) 

 Even if the date format is changed (Configuration| Date and Time Settings) when you create a report 

the default date format will be used (MM/DD/YYYY) 

 Scheduled reports: the default email report format is PDF document. To send the report in other format 

be sure that the Export data in option is checked and the desired report format is selected 

 When a report is exported as Word for Windows document (.doc) the Distribution Graph's legend 

doesn't display the colored lines (only their names) – Crystal Reports issue 

 When the reports are exported as Text or Paginated Text documents the first (and last) characters 

aren’t displayed. To avoid this increase characters per inch value when prompted 

Call Log 
 If the Forward mode is set to FWD All (Call from CO) for an extension there will be no information 

regarding that extension, ACD Report Server will monitor only the extension that is set up to receive the 

forwarded calls. 

 For time-related Lookup fields (e.g. Talk Time), no matter of Timers Format options value, you must 

enter the total number of seconds you are searching for 

Host Requirements 

The minimum requirements for ACD Client Application Windows host: 

 Operating System – Microsoft Windows 2000 Professional (Service Pack 4 and later), Windows XP 

Professional (Service Pack 2), Windows XP Home Edition (Service Pack2) 

 CPU – Celeron at 1 GHz  

 RAM – 256 MB  

 HDD – 2 GB free disk space 

 VIDEO – 1024x768 

 LAN – 10 Base T  

The recommended requirements for ACD Client Application Windows host: 
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 Operating System –Windows XP Professional (Service Pack 2), Windows XP Home Edition (Service 

Pack2) 

 CPU – Pentium IV at 1.6 GHz or greater 

 RAM – 512M or greater   

 HDD – 5GB free disk space 

 VIDEO – 1280x1024 

 LAN – 10 Base T or greater 
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Installation Procedure 

To install the ACD Report server Client application  

1. Double-click the ACD_Report_Server.exe on the installation CD to start the ACD Client Application 

installer application. Wait for the ACD Report Server Install Shield Wizard to launch. 

 

2.  The ACD Report Server Install Shield Wizard is displayed 
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3. Click the Next button. The License Agreement screen will appear 

 

4. Read the License Agreement and if you agree click on the Yes button 

5. The Destination Folder screen appears 

 

6. Choose the path you want the ACD Report server Client application to be installed (the default path is 

C:\Program Files\Panasonic\ACD Report Server) 
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7. Click the Next button. The wizard starts to install the ACD Client Application components 

 

8. Wait until the wizard informs you that the installation is completed 

 

9. Click on the Finish button to close the install wizard 

10. Now you have the application installed on your computer and ready to be used. 

 
NOTE: For more details on how to use ACD Client Application, please refer to ACD 
Report Server User’s Guide section or browse the specific topics in the ACD Report 
Server Windows Help System. 
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To repair the ACD Report server Client application 

1. Go to Start> Settings> Control Panel >Add or Remove Programs 

2. Select from the list ACD Report Server and click on the Change/Remove button 

 

3. Enable the Repair option and click on the Next button 

 

4. The Repair procedure is now completed. 

To uninstall the ACD Report server Client application 

1. Go to Start> Settings> Control Panel >Add or Remove Programs 

2. Select from the list ACD Report Server and click on the Change/Remove button 

 

3. Enable the Remove option and click on the Next button 

 

4. Confirm the uninstalling by clicking on the OK button 
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5. The wizard informs you when the uninstalling is completed  

 

NOTE: After you uninstall the ACD Report server Client application the folder and data 
files will remain at the chosen path during the installation. If you do not need these files 
you can delete them manually. 
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Settings for ACD Report Server 

Connecting the PBX to the LAN 
Set the IP address for the PBX. Refer to the Installation Manual of the PBX for the procedure. 

Configuring the IP for Voice Processing System/ ACD Report Server 
Refer to the Installation Manual of Voice Processing System for the hardware connection of KX-NCV200 

and PC. 

1. Inside the KX-TVA/NCV Maintenance console go to Utility> LAN Settings  

2. Enable Use the following IP address and fill in the necessary information 

 

3. Click on the OK button. 

Configuring the PBX - Setting the Dial Information (CTI) Number 

NOTE: This PBX setting is needed for the ACD Report Server in NCV Agent Mode. 
1. Inside the KX-TDA maintenance console go to: 2.System > 6.Numbering Plan > 1. Main>Features 

2. Scroll down the Feature list and go to number 65. Dial Information (CTI) and type the desired number. 

 

3. Click on the Apply button to save the change. 
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Start the ACD Report server Client application 
1. Run ACD Report server Client application from Start | Programs | Panasonic | ACD Report Server | 

ACD Report Client. The ACD Report Server Log In dialog will be displayed 

 

2. Enter the Password and click OK. The ACD Report Server main window is displayed. The default 

Password is 1234. 

Note that you can change the server location at every login by clicking on the Server Location button, 

before specifying the password. Inside the Server Location window specify the server address and port 

number of the Voice Processing System. 

 

When you change the PBX, the Database Clear has to be selected here. Otherwise, KX-
NCV200 operates incorrectly as the old data still remains. You do not have to clear the 
Database when only the IP address of the PBX changes. The default port is 10001. 
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Connect the ACD Report Server to the PBX 
Before using the ACD report Server you need to connect the ACD Report Server to the PBX. Follow the 

steps below: 

1. Start the ACD Report Server. At first, the ACD Report Server is not connected to the PBX. Go to 

Configuration> Configuration Settings. The default password is 1234. From Current System State the 

PBX Connection field is Disconnected. 

 

2. Type the IP Address of the PBX inside the corresponding field and click on the Apply settings button. 

3. The ACD Report server Client application will restart 
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4. Open the ACD Report server Client application and go to Configuration> Configuration Settings. The 

default password is 1234. From Current System State the PBX Connection field should by Connected 

indicating that the ACD Report Server application is connected to the PBX. 

 

NOTE: The default port is 10001 for Server Connection, and 33333 for PBX Connection. 
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Agent Setting 
The ACD Report Server presents the user with the option of giving each Agent an unique ID number which 

will be used to monitor the Agent’s activity. The ID number associated with an Agent must first be defined 

inside the Agents Data section. However, this feature is optionally and the user can select the ACD Report 

Server operation mode.  

Inside the Configuration Settings section the Agent Setting fields: 

 Extension Mode – if the Extension Mode is selected the ACD Report Server monitors each extension 

activity 

 NCV Agent Mode – if the NCV Agent Mode is selected the ACD Report Server monitors each Agent 

activity. The Agents have to log in using their Agent ID and password defined inside the Agents Data 

section, for further information please consult ACD Report Server User’s Guide 

Click on the related Apply Settings button to save a change in this field. 

 

NOTE: When the Agent Setting is changed: 
 From Extension Mode to NCV Agent Mode – the ACD Report Server logs out all the Agents and then 

the ACD Report Server application is restarted. 

 From NCV Agent Mode to Extension Mode – the ACD Report Server logs out all the Agents the ACD 

Report Server application is restarted and all the physically connected extensions are available, each 

extension to its corresponding group(s). 

NOTE: 
When the ACD Report Server is in the NCV Agent Mode, an Agent can also log out from 
a Group dialing *7360, but an Agent cannot log into a Group dialing *7361. 
Enable Last Extension Log-out – refer to the Manual of the PBX for details. 
When the ACD Report Server is in the Extension Mode an extension can log in using 
*7361 and can log out using *7360. 
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Agent Log in 

NOTE: When the ACD Report Server is in the NCV Agent mode the Agents log in using 
their Agent ID and password. See the procedure below. 
To log in an Agent has to dial the following numbers: 

CTI  
Dial 
Information 
Number 

+ Login  
No 

+ Agent ID + Password + Group No 

 CTI Dial Information number – see the Setting CTI number section 

 Login No – the Log in No is “1” 

 Agent ID – each Agent has an unique 4 digits code set inside the Agents Data section (for further 

information see the ACD Report Server User’s Guide)  

 Password – each Agents has a password (for further information see the ACD Report Server User’s 

Guide) 

 Group No – the group number the Agent wants to log in  

After an Agent is logged in, the Agent will hear a confirmation sound. If the Agent fails to login he will hear a 

reorder tone. 

To log out an Agent has to dial the following: 

CTI  
Dial 
Information 
Number 

+ Logout  
No 

+ Agent ID + Password + Group No 

 CTI Dial Information number – see the Setting CTI number section 

 Logout No – the Log out No is “0” 

 Agent ID – each Agent has an unique 4 digits code set inside the Agents Data section (for further 

information see the ACD Report Server User’s Guide)  

 Password – each Agents has a password (for further information see the ACD Report Server) 

 Group No – the group number the Agent wants to log out  

After an Agent is logged out, the Agent will hear a confirmation sound. If the Agent fails to logout he will hear 

a reorder tone. 

NOTE:  
When an Agent logs out from the system, the Agent has to use the same extension as 
the one that the Agent used for login. 
An Agent can log in using only one extension. 
You cannot use *(All) while dialing a Group No. 
The Agents cannot log in a PS Ring Group. 
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ACD Report Client Initialize 

1. Run ACD Report Client from Start | Programs | Panasonic | ACD Report Server | ACD Report Client. 

The ACD Report Server Log In dialog will be displayed 

 

2. Enter the Password and click OK. The ACD Report Client main window is displayed. The default 

Password is 1234. 

Note that you can change the server location at every login by clicking on the Server Location button, 

before specifying the password. Inside the Server Location window specify the server address and port 

number of the Voice Processing System. The default port is 10001. 

 

Inside the Server Location window you have to choose: 

 Clear the Client database – use this option when you change the PBX  

 Do not clear the Client database – this is the default option 
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Client Application User’s Guide 

Introduction 

This section covers the following topics: 

 Starting the Client Application 

 Client Application Main Window 

 Configuring the Basic Settings 

 Managing the Configuration Settings 

 Managing Customer Data 

 Managing Agent Data 

 Monitoring the ACD 

 Generating Reports 

 Call Log 

 Agent Log 



 

Client Software Installation Manual           29  

 

Starting the Client Application 

To start the Client application: 

1. Run ACD Report Server from Start | Programs | Panasonic | ACD Report Server | ACD Report Client. 

The ACD Report ServerLog In dialog will be displayed 

 

2. Enter the Password and click OK. The ACD Report Client main window is displayed. The default 

Password is 1234. 

Note that you can change the server location at every login by clicking on the Server Location button, 

before specifying the password. Inside the Server Location window specify the server address and port 

number. 

 

When you change the PBX, the Database Clear has to be selected here. Otherwise, KX-
NCV200 operates incorrectly as the old data still remains. You do not have to clear the 
Database when only the IP address of the PBX changes. The default Server port is 
10001. 
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Client Application Main Window 

Overview 
After you logged-in with ACD Report Server, the main window opens like presented below. 

 

By keeping the Views window opened, you can easily access the main sections of the application. 

In the Views window you have the following sections, which can be accessed from the main menu:  

 Configuration – allows you to configure general settings regarding monitoring and reporting 

parameters, the database maintenance and server settings 

 System Data – allows you to manage customer information centralized in the internal database and the 

Agents Data 

 ACD – allows you to: 

 Monitor important parameters relating to PBX performance in real time using Counters and 

Performance Graphs 

 Generate various types of custom reports on the ACD activity 

 View the Call Log information  
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 View the Agent Log information 

NOTE: Restart the Server and the Client when you change the PBX settings. Restart the 
Client when you turn the KX-NCV200 OFF and then ON. 

Main Menu 
The options available from Client application Main Menu are: 

 File 

 Edit 

 View 

 Window 

 Help 

File Menu 

Menu Options Description 

Change Password Allows the user to change the login password (Client Settings). Please 
be careful that you cannot connect to the Client if the login password is 
lost. 

Change Configuration 
Password 

Allows the user to change the password for the Configuration Settings 
window (Server Settings) 

Change Agent Setting 
Level2 Password 

Allows the user to change the level 2 password for the Agents data 
section (Client Settings). The Agent Setting Level2 password allows 
you to see the Agents data but you cannot modify the Agents Data. 

For more details see The Agents Data Access Levels 

Change Agent Setting 
Level3 Password 

Allows the user to change the level 3 password for the Agents data 
section (Client Settings). The Agent Setting Level3 password allows 
you to see the Agents data and you can modify the Agents Data. 

For more details see The Agents Data Access Levels 

Change Logo 

 
Allows the user to change the logo picture on the reports (Client 
Settings) 

Exit Allows the user to exit and close the application 

Edit Menu  

Menu Options Description 

Cut Delete the current selection but save it to clipboard 

Copy Copy to clipboard the current selection 

Paste Copy to the current location the information existing in clipboard 
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View Menu 

Menu Options Description 

Status Bar Show/ Hide Status Bar 

Monitor Counters Bar Show/ Hide Status list when ACD Monitor pane 
is displayed 

Basic Settings Open the Basic Settings window (see the 
Configuring the Basic Settings section) 

Configuration 

Configuration 
Settings 

Open the Configuration window (see the 
Managing the Configuration Settings window 
section) 

Customer Data  Open the ACD Customers window (see the 
Viewing/Modifying Customer Information 
section) 

System Data 

Agent Data Open the Agent Data window (see the 
Managing Agents Data section) 

ACD Monitor Open the ACD Monitor System window (see the 
ACD Monitor System section) 

Performance 
Graph 

Open the Performance Graphs window (see the 
Performance Graphs section) 

ACD Reports Open the ACD Reports window 

(see ACD Reports section) 

Call Log Open the Call Log window  

(see the Viewing Call log Information section) 

Go to 

ACD 

Agent Log Open the Agent Log window  

(see the Viewing Agent Log Information section) 

Views Show/ Hide the Views window 

Previous 

Next 

Navigate between the opened windows 

Window Menu 

Menu Options Description 

Cascade  Cascade all opened windows 

Tile Arrange all opened windows in Tile mode 

The names of the opened 
windows 

You can see a list with the opened windows, in their opening order 

Windows… Opens a window where you can see the opened windows and 
perform actions such as Activate, Close, Minimize, and arrange 
(Cascade, Tile Horizontally, Tile Vertically) 
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Help Menu 

Menu Option Description 

ACD Report Server 
Help Contents 

Open the ACD Report Server Help window with the Contents section in 
the left pane 

Index Opens the ACD Report Server Help with the Index 

Search Opens the ACD Report Server Help with the Search section, allowing you 
to lookup for a particular term 

Enable all tips Enables all tips 

About ACD Report 
Server … 

Opens the About ACD Report Server window 
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Configuring the Basic Settings 

To access the Basic Settings window click the Basic Settings button in Views>Configuration or choose 

from the main menu View>Go to>Configuration>Basic Settings. 

 

Here you can set, according to your preferences, the following items: 

 Date and Time Settings – allows you to select the format you want the time information to be displayed 

(for example, the Ring Time field in the ACD>Call Log section) 

 Counters reset time of every day – specify the time you want the counters from the ACD Monitor 

window to be reset every day (Client Settings) 

 Other ACD Settings – specify the Abandoned Call Threshold Time (an incoming call is abandoned if it 

exits the system before the Threshold Time expires) 

 Timers Format Options – select the time measurements units used in the system 

 Email Server for Reports – set the SMTP mail server information, which will be used to automatically e-

mail the scheduled reports, set in the ACD Reports section. In order for the scheduled reports e-mailing 

feature to work properly with all e-mail servers, all the following settings must be provided: 

 Server Name – the name or the IP address of the SMTP server where the manager holds an email 

account (e.g. smtp.communications.com) 

 Port – the port number used by the e-mail server to send mails (by default, and generally used - 

port number 25). Do not modify the default value (25) if you are not sure that the server uses 

another port for SMTP messages 

 Account – the name of the mail account 
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 Password – the password of the mail account 

 Email Address – the mail address of the current account (e.g. support@communications.com) 

 Database maintenance: 

 The Server Data button– performs the operations of back-up or restore the Server Database 

 

Server Data operations: 

1. Server Data Backup database 

To perform the Server Backup database operation check the Backup database option and select 

the path. The Client Software is restarted and a back-up file is created at the chosen destination. 

The following files are created at the chosen destination (the default path is C:\Program 

Files\Panasonic\ACD Report Server\Backup): 

 .agents – the database file with Agents data (only for Agent Mode) 

 .config – contains the Server settings 

2. Server Data Restore database 

The Server Restore operation allows you to restore previously saved database and settings. To 

perform the Server Restore database operation check the Restore database option and select the 

path for the Server Database you wish to restore. 

NOTE:  
The calls information stored in the Server cannot be backed up or restored. 
The database can not be restored if the file “.config” is missing. 
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 The Client Data button – performs the operations of compact and back-up or restore the Client 

Database 

 

Client Data operations: 

1. Client Data Backup database: 

To perform the Server Backup database operation check the Backup database option and select 

the path. The Client Software is restarted and a back-up file is created at the chosen destination. 

The following files are created at the chosen destination (the default path is C:\Program 

Files\Panasonic\ACD Report Server\Backup):  

 counterssave.bck – contains counters values 

 default.bck – contains Client settings 

 KME-CMS-BK.mdb – the Client database (details about all the calls) 

 ncvlibrarysave.bck  - contains the offset of data from the Server 

2. Client Data Restore database: 

The Client Restore operation allows you to restore previously saved database and settings. To 

perform the Client Restore database operation check the Restore database option and select the 

path for the Client Database you wish to restore. 

To set the Date Format choose from the dropdown list in the Date and Time Settings section between: 

 DD/MM/YYYY 

 MM/DD/YYYY 

 YYYY/MM/DD 

To set the Time Format choose from the dropdown list in the Date and Time Settings section between the 

12 hours and 24 hours format. 

To set the Timers Format select one of the following from the Timers Format Options: 

 Seconds (ss) 

 Minutes (mm:ss) 

 Hours (hh:mm:ss) 
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To set the Counters reset time of every day specify the time you want the counters to be reset everyday.  

To set the Abandoned Call Threshold Time insert the number of seconds to prescript when a call is 

abandoned or when it is not. 
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Managing the Configuration Settings 

To access the Configuration Settings window click the Configuration Settings button in 

Views>Configuration or choose from the main menu View>Go to>Configuration>Configuration Settings. 

1. To access the Configuration Settings you must first insert the password. The Configuration Settings 

password is different from the password that opens the ACD Reports Server or the passwords from 

Agent Data. The default password is 1234. 

 

To change the password from the main menu: File > Change Configuration Password
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2.    Now, the Configuration Settings window is displayed.  
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The Current System State fields: 

 NCV200 Server State – shows the state of the NCV200 Server 

 PBX Connection – shows the state of the PBX Connection (when the Server is connected to the PBX 

this field should be Connected) 

 Database Server – shows the state of the Server Database 

 Database Path – shows the path for the Client Database 

You can restart the Server using the Restart button. 

The PBX Setup fields: 

 IP Address – specify the IP address of the PBX 

 Port – specify the port number of the PBX (for more details regarding TCP/IP connection, please 

consult your Dealer) 

Click on the related Apply Settings button to save a change in this field.  

The Server Setup allows you to change the Server port number. Click on the related Apply Settings button 

to save a change in this field. 

The Server Update allows you to update the ACD Reports Server. The Client Software is closed and the 

Server restarts automatically. Select the update file path and click on the related Update button to update 

the ACD Report Server. 

The Database store period allows you to choose the period of time the Server database information is 

stored: 

 1 week 

 1 month 

 Custom period – choose from the dropdown list the number of Days, Months, Years and type the 

desired number or choose to store the Server database information on an Unlimited period of time 

Click on the related Apply Settings button to save a change in this field. 

NOTE: Please make the ACD Client application connect to the Server at least once 
within the chosen period. 

The Client Debug Log Settings: 

 Debug Log – information about monitoring process and Server communication 

 CSTA Log – logs information about CSTA protocol decoding 

 ROSE Log – logs information about ACSE protocol decoding 

 CSTA: Functions Log – detailed information about CSTA processing 

 CSTA: Debug Log – detailed information about CSTA processing 

 CSTA Decode Log – logs all decoded CSTA messages 
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The Server Debug Log Settings: 

 TCP/IP – logs socket and TCP/IP information 

 Agent DB – logs information about Agent DB and Agent Mode processing 

 Raw CSTA DB – logs CSTA processing of Server 

 Error Log – logs application errors 

 Detailed Debug Log – logs detailed information about Clients communications and all server 

activities. 
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The Agent Setting 
The ACD Report Server presents the user with the option of giving each Agent an unique ID number which 

will be used to monitor the Agent’s activity. The ID number associated with an Agent must first be defined 

inside the Agents Data section. However, this feature is optionally and the user can select the ACD Report 

Server operation mode.  

NOTE: The change Extension Mode to NCV Agent Mode or the change NVC Agent Mode 
to Extension Mode should be done only on initial setup of the system, not when the 
system is working. 

The Agent Setting fields: 

 Extension Mode – if the Extension Mode is selected you can not see the Agent ID inside the ACD 

Report Server sections  

 NCV Agent Mode – if the NCV Agent Mode is selected, it is possible to see the Agent ID as a field 

inside the ACD Report Server sections. 

Click on the related Apply Settings button to save a change in this field. 

NOTE: When the Agent Setting is changed from Extension Mode to NCV Agent Mode 
the ACD Report Server logs out all the Agents and then the ACD Client application is 
closed. 
When the Agent Setting is changed from NCV Agent Mode to Extension Mode the ACD 
Report Server logs out all the Agents and the ACD Report Server application is closed 
and all the physically connected extensions are logged in to the corresponding 
group(s). 
The Compulsory Agent logout setting: 

When the NCV Agent Mode is selected it is possible to perform compulsory logout operation for all the 

Agents. 

 Enable Specify the logout time option and select the time – all Agents will be logged out at the specified 

time everyday. 

 

While NCV200 is working with Agent mode and Compulsory Agent Logout setting is 
enabled, extension will be forced to logout in the following cases. 
1. When pass the time of Compulsory Agent Logout setting. 
2. Extension status is changed from Out Of Service (OUS) into In Service(INS). 
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Viewing/Modifying Customer Information 

Overview 
The Customer Data section allows the System Manager to register new customers in the database, as well 

as to modify/delete their data. 

The Customer History section provides information about all calls handled for each customer in the 

database. 

This section contains information about the main operations you can perform on Customers data in the 

internal database: 

 Adding/Removing a Customer from the database 

 Viewing/Modifying Customer information 

 Viewing all past calls information for a particular Customer 

To access the ACD Customers window click on the Customer Data button in the Views >System Data 

window, or choose from the main menu View>Go to>System Data>Customer Data. 

 

Here you can see a list with all the customers in the database, identified by Name and Caller ID. 
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In the table below you can see the main operations you can perform on the Customer information: 

Item Description 

The  Add Customer button  
You can choose to add a new customer or to duplicate an 
existing one 

The  Delete Customer button  
Allows you to remove an existing Customer from the 
database by selecting the Customer from the list and then 
clicking the Delete Customer button 

The  Import button 
Allows you to import the Customer data from a specified 
source – see the procedure description below 

The  Export button 
Allows you to export the Customer data and save it to a 
specified destination file – see the procedure description 
below 

Customer Properties Set/modify the Customer data  

History See all calls information for the selected Customer 

The  Previous 
button 

Allows you to move up one position in the Customers list 

The  Next button 
Allows you to move down one position in the Customers list 

Initial Date Displays the date the Customer was added to the database 
for the first time 

Update Date Displays the date on which the Customer data was updated 
the last time 

The  Apply button 
Used to save the changes made to a particular Customer 
data 

To add a new customer: 

1. Click the Add Customer button and choose from Add New Customer or Duplicate Customer 

2. Fill in the Customer information 

3. Click the Apply button 

To remove a customer select the customer from the list and click the  Delete button. 

The type of data you should import is columnar data, which contains one or more of the following fields: 

Caller ID, Caller Name, First Name, Middle Name and Last Name. See the procedure below. 

To import Customer data: 

1. Click the Import button. The Select Source dialog box will be displayed. The supported formats are: 

mdb (Microsoft Access Database), xls (Microsoft Excel File), csv (Comma Separated Values), dsn 

(Data Source), and dbf (Act Contacts Database) 

2. Select from the Source Type dropdown list the file type you want to import the data from 

3. Click the Browse button. The Open dialog box appears 

4. Browse and select the file containing the data to be imported  
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5. Click Open to open the file and exit the dialog box. You are now in the Select source window again 

6. Click the Next button to continue the procedure. The Choose Fields window opens. Here you can see a 

list with the information source fields (Source Table) which can be mapped to the desired internal 

database fields by dragging them to the Mapped Fields in the Current Mapping section. By default if 

inside the source file a filed name corresponds to an existing field inside the Customer Data window, 

the two fields will be mapped together. 

7. Click the Finish button to perform operation 

Example 

In this example you will see how to import customer information from an mdb file, inside the Customer Data 

window. 

1. Click the Import button. The Select Source dialog box will be displayed 

 

2. Browse and select the source file 
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3. In the Table view select the information you wish to import from the source file: customers 

 

4. Click the OK button. 
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5. Click the Next button to continue the procedure. The Choose Fields window opens. By default if inside 

the source file a filed name corresponds to an existing field inside the Customer Data window, the two 

fields will be mapped together. 

 

6. If you wish to import inside the Caller ID field the Business_Phone field from the source file, simply 

select the Business_Phone from the Source Fields and drag it to the Mapped Fields column to the 

Caller ID field from the Destination Fields column 

 

7. Now, click on the Finish button to complete the operation 
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To export Customer data to a file: 

1. Click the Export button. The Save as dialog box appears 

2. Select the file where you want to save the information 

3. Type the desired file name, the file type is csv(comma separated values) 

4. Click the Save button to perform operation 

The files with the format of csv(comma separated values) are easily viewed and managed with applications 

for data in columnar format, for example applications for spreadsheets or databases. 
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Viewing/ Modifying Customer Data 
By clicking the Customer Properties tab you can view/modify the Customer information. 

The Customer Properties: 

 Caller ID – displays the customer phone number 

 Caller Name  - if you fill in for a customer the Caller Name, when the Caller Name is received from the 

CO, the customer is recognized by its Caller Name  

 First Name – the customer first name 

 Middle Name – the customer middle name 

 Last Name – the customer last name 

 

Modifying the Customer information: 

1. Select the Customer Properties tab 

2. Select the desired Customer from the list 

3. Modify the Customer Properties 

4. Click on the Apply button to save the change. 

Viewing History 
To see the information about all calls of the selected Customer click the History tab. 

Lost calls are marked in red. 

You can select the call information you want to see by clicking the Field Chooser button and select from the 

list in the Select visible fields window one or more of the following call parameters: 

 Call Log ID – every call the system handles receives an ID number 

 Date/Time – displays the date and time the call arrived in the ACD Queue or the Agent 

 Completion Time – the time the call was completed 

 Customer – displays the full customer name (First, Middle and Last) 

 Caller ID – displays the customer phone number 

 Caller Name  – available only if it is received from the CO 

 Incoming/Outgoing – type of the call 

 Status – displays the call status: 

 ACD 
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 Non ACD 

 Lost ACD 

 Abandoned 

 Dialed Number – the number the customer dialed 

 DDI/DID/MSN – the DDI/DID/MSN data (number) from the public exchange (CO) 

 DNIS – Dialed Number Identification Service 

 ANI – Automatic Number Identification 

 Trunk – CO line number used for that call 

 Talk Time – the length of time the call was in conversation with Agents 

 Wait Time – the length of time the call waited in the ACD Queue and rang at Agent (Queue Time + 

Ring Time) 

 Hold Time - the length of time a call was placed on hold by the Agent 

 Ring Time – the length of time the Agent extension has rang while the call has been left unanswered 

 Queue Time – the period of time spent waiting in the ACD Queue 

 Call Duration – the total time spent in the system from the moment the call entered until it exits the 

system 

 Number of Overflowed – the number of times the call was transferred because of overflow  

 Number of No Answered – the number of times the call was not answered 

 Number of Transferred – the number of times one Agent transferred the call to another extension 

(Agent) or ICD Group 

 Number of Conference – a conference is a call with at least 3 participants. Number of Conference 

increases every time when a call changes from 2 to 3 participants. 
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Managing Agents Data 

NOTE:  
This feature is available only in NCV Agent Mode. 
The Agent Data can not be edited while the Agent logs in an extension. The Agent has 
to log out before editing the data. 

This section provides you with information about the main operations you can perform on an Agent: 

 Adding a new Agent 

 Removing an existing one 

 Setting/modifying the Agent data 

To access the Agent Data window click the Agent Data button from Views>System Data or choose from 

the main menu View>Go to>System Data>Agent Data. 

1. To access the Agent Data you must first insert the password. The default password is 1234. 

 

2. Now, the Agent Data window is displayed. 

 

For each Agent the following fields are available: 

 Agent Name – the complete Agent Name (max. 20 characters) 
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 Agent ID – each Agent has an unique 4 digits code (0-9) 

 Password – each Agent has a password of 4 digits (0-9) 

 Confirm password – when adding a new agent or changing the Agent password you need to retype 

the password in this field 

NOTE: During the NCV Agent Mode (see the Agent Setting section) an Agent logs in the 
system using the Agent ID and the password. 

In the table below you can see the main operations you can perform on the Agent information: 

Item Description 

The  Add Agent button  
You can choose to add a new Agent or to duplicate an 
existing one. The default Agent ID is 9999. 

The  Delete Agent button  
Allows you to remove an existing Agent from the database 
by selecting the Agent from the list and then clicking the 
Delete Agent button 

The  Previous 
button 

Allows you to move up one position in the Agents list 

The  Next button 
Allows you to move down one position in the Agents list 

The  Import button 
Allows you to import the Agent data from a specified source 
– see the procedure description below 

The  Export button 
Allows you to export the Agent data and save it to a 
specified destination file – see the procedure description 
below 

The  Apply button 
Used to save the changes made to a particular Agent data 

To add a new Agent: 

1. Click the Add Agent button and choose from Add New Agent or Duplicate Agent 

2. Fill in the Agent information 

3. Click the Apply button 

To remove an Agent select the Agent from the list and click the  Delete button. 
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To export Agents data to a file: 

1. Click the Export button. The Save as dialog box appears 

 

2. Select the file where you want to save the information 

3. Type the desired file name, the file type is csv(comma separated values) 

4. Click the Save button to perform operation 

The files with the format of csv(comma separated values) are easily viewed and managed with applications 

for data in columnar format, for example applications for spreadsheets or databases. 

To import Agents data: 

1. Click the Import button. The Open dialog box will be displayed. The supported formats are: csv 

(Comma Separated Values)  

2. Select the file type you want to import  

3. Click the Open to perform the operation 

NOTE: The imported file contains Agent Name, Agent ID and password. If same Agent 
ID exists on the server side and only the Agent Name is different, that item not be 
imported. 
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The Agents Data Access Levels  
The Agents Data provides the user with 2 access levels delimitated by passwords: 

 Agent Setting Level 2: Allows you to see the Agents data but you cannot modify the Agents Data. You 

can change this password from the main menu: File>Change Agent Setting Level2 Password and follow 

the steps bellow: 

1. Type the old password. The default password is 1234. 

2. Type the new password 

3. Retype the new password 

4. Click on the Ok button 

 

You can see in the picture below that the Agent Data fields are not available to be modified. 

 

 Agent Setting Level 3: Allows you to see the Agents data and you can modify the Agents Data. You 

can change this password from the main menu: File>Change Agent Setting Level3 Password and see 

the steps above. The default password is 1234. 
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Monitoring the ACD 

Overview 
ACD section provides tools for analyzing the call center performance and productivity through both real-time 

and historical information including: 

 Real-time counters - enable call center management to streamline call log operations and you can 

make decisions such as re-assignments of the Agents to achieve the optimum call center performance. 

 Performance graphs - real-time statistics and comparative graphs (custom or predefined) on 

Agents/Groups/System performance and status. 

 Statistical reports – you can generate different custom reports by choosing the items you want to 

analyze, the period of time the report will be generated and adding it to a schedule 

 Call Log information - a detailed history of each call that enters the system: who was the caller, whether 

and how long the caller waited in queue, call duration, etc. 

 Agent Log information - a history of each Agent log-in/out date and time, the time spent in each of the 

four possible states (Idle, Busy, Break (Out Of Service), Wrapup) and handled calls information. 
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ACD Monitor System 
ACD Monitor System allows you to monitor in real-time the ACD operational status of the PBX system. 

By analyzing counters that will be displayed on the screen lively, you can make decisions such as re-

assignments of the Agents to achieve the optimum call center performance. 

To access the ACD Monitor window click on the ACD Monitor button from the Views>ACD window, or 

choose from the main menu View>Go to>ACD> ACD Monitor: 

 

The table below describes the main operations you can perform on ACD Monitor System: 

Item Description 

The  Layout 
button 

Allows you to view and configure the available counters and timers 
for the selected item in the ACD System list 

The  Choose 
Fields button 

Allows you to choose the visible fields inside the Monitor Counters 
Bar for the selected item in the ACD System list. 

See the  Monitor Counters Bar subsection. 

The  Reset 
Counters button 

Allows you to reset all the counters 

NOTE: If you execute 'Reset Counters' when there are 
calls on the system, some counters might show an 
invalid value. (e.g. System Cumulative Counter: Lost 
ACD Calls (%)) 
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Item Description 

The  
Rearrange Counters button 

Allows you to rearrange the displayed counters 

The ACD Report Server manages the following type of counters and timers: Active Counters, Cumulative 

Counters, Peak counters, Active Timers and Cumulative Timers. 

User has access to real-time counters and timers, such as: 

 Total Incoming Calls (Active Counter) – displays the total number of incoming calls currently being 

handled by the system  

 Outgoing Calls (Active Counter) – displays the number of outgoing calls that are currently being 

handled by the system  

  Waiting Calls (Active Counter) – displays the total number of calls (ACD and Non ACD) that are 

currently waiting  

 Lost ACD Calls (Cumulative Counter) – displays the total number of lost ACD calls handled by the 

system since the beginning of the session  

 Total Incoming Calls (Cumulative Counter) – displays the total number of incoming calls handled by 

the system since the beginning of the session 

 Outgoing Calls (Cumulative Counter) – displays the total number of outgoing calls handled by the 

system since the beginning of the session 

 Call Duration (Active Timer) – displays the currently status of the call (ACD, Non ACD, Outgoing etc.) 

and the total time spent in the system from the moment the call entered until it exits the system 

 Talk Time for ACD Call (Cumulative Timer) – displays the length of time the call was in conversation 

with Agents 

 Total Waiting Time for ACD Call (Cumulative Timer) – displays the length of time the call waited in the 

ACD Queue and rang at Agent, and more. 

Call Status 
In the ACD Monitor window you can see a tree view icons that provide you with an easy understanding of 

the real-time call handling status in the system. 

 ACD System – provides real-time monitoring of calls being handled by the system 

 ACD Group – provides real-time monitoring of calls being handled by the selected Group 

 ACD Agent – provides real-time monitoring of calls being handled by the selected Agent 

 Queue – provides real-time monitoring of calls currently waiting in the ACD Queue. It allows you to 

monitor both current and statistical data of the calls being held in the ACD Queue, as well as detailed 

information on queuing status for each ACD Group. The information given will help you shorten the 

average waiting time by controlling the number of Agents for each ACD Group 
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By clicking on the icons in the tree view window you can see: 

 The System status: 

  - System offline 

  - System online 

 The agents logged-in for each group and their status: 

  - Busy 

  - Idle 

  - Break, Out of Service 

  - Wrapup 

 Call status: 

  - Off Hook 

  - Talking – outgoing call 

  - Talking – incoming call 

  - Ringing (Ringback) 

  - Alerting 

  - Conference 

  - Hold 

 - Disconnected 

NOTE:  
During the NCV Agent Mode only the logged in Agents are visible inside the tree, during 
the Extension Mode only the physically connected extensions logged-in the ACD 
Groups are visible inside the tree. 
When you call a Group the group number is not displayed in the ACD Tree. 
The calls waiting in the Queue have the “Hold” icon. 
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Working with Counters 
The Call Counters and Timers, which you can see on the right side of the ACD Monitor window, provide the 

statistics of various important parameters relating to the general performance for the selected item in the 

tree. 

This feature allows you to real-time monitor the activity of each component of your system (the ACD System, 

ACD Group, logged-in Agent, and Queue) 

For the selected item in the tree window you can see two important counters by default. 

The timers will be displayed using the time format set in the Basic Settings 

Adding Counters 

To add a counter to the right side of the ACD Monitoring window click on the  icon in the upper-right 

corner of a counter and the new counter will appear behind that counter. Now, click on the Rearrange 

Counters button to rearrange the displayed counters. 

You can configure the new counter according to your needs, see below the procedure. 

Configuring Counters 

To configure a particular counter, click on the  icon in the upper-right corner of that counter or select the 

Layout button. The Select and Configure Counter window will be displayed, where you can select the 

desired counter type from a list and optionally set: 

 

 In General>Display Name type the name of the counter that will be displayed 

 In General>Threshold specify a threshold value to receive alarm signs (for example when too many 

calls have been lost) 

 In General>Threshold Action choose an audible alarm by Play a Wave or/and a visual alert by Flash 

Main Window, when the threshold value is over-passed 



 

60          Client Software Installation Manual  

 In Colors section you can set: 

 The text color for the selected counter when the threshold value is over-passed – by clicking on the 

Threshold Color section and selecting the desired color from the color palette. You can restore at 

any time the default settings by clicking on the Reset Defaults button 

 The text color for the selected color in the normal case by clicking on the Normal Color section and 

selecting the desired color from the color palette The background color for the selected counter by 

clicking on the Background Color section and selecting the desired color from the color palette 

 

 In Fonts section you can choose the font style and size for the text that will be displayed for the selected 

counter 

 

To close a counter click on the  icon in the upper-right corner of the counter. 
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Monitor Counters Bar 
Inside the ACD Monitor window, go to the main menu View and enable Monitor Counters Bar.  

Now you have access to all the available counters and timers depending on the selected item inside the 

ACD tree (ACD System, Queue, Group or Agent). 

 

The table below describes the buttons available in the Monitor Counters bar (depending on the selected item 

inside the ACD tree): 

Item Description 

The  Active 
Counters button 

Click this button to view the available active counters in the Monitor 
Counters Bar 

The  
Cumulative Counters button 

Click this button to view the available cumulative counters in the 
Monitor Counters Bar 

The  Peak 
Counters button 

Click this button to view the available peak counters in the Monitor 
Counters Bar 

The  Active 
Timers button 

Click this button to view the available active timers in the Monitor 
Counters Bar 

The   
Cumulative Timers button 

Click this button to view the available cumulative timers in the 
Monitor Counters Bar 
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To choose the Monitor Counters Bar information fields to be displayed: 

1. Enable Monitor Counters Bar from the View Menu 

2. Select the desired item to monitor inside the ACD tree (ACD System, Queue, Group or Agent) 

3. Click on the Choose Fields button 

 

All the available fields are described inside the Appendix: Counters and Timers 
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Performance Graphs 

This section allows you to see different real-time statistics and comparative graphs (custom or predefined) 

on Agents/Groups/System performance and status. 

To access the Performance Graphs window click on the Performance Graphs button in Views>ACD 

window or choose from the main menu View>Go to>ACD>Performance Graphs 

 

Predefined Performance Graph 

To add a new predefined performance graph: 

1. Click the New button 

2. Choose the Predefined Performance Graph option and click the Next button 

3. Choose the desired graph from the list in the Available Graphs section: 

 Horizontal Bar – Agents Status – this graph will display in real-time the agents status using 

horizontal bars  

 Vertical Bar – Evolution Agent – this graph will display in real-time the evolution of one agent 

using vertical bar  
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 Vertical Bar Percentage Stacked – Instant Agents – this graph will display in real-time for the 

selected agents the percentage of time for each status 

 Vertical Bar Percentage Stacked – Evolution Item – this graph will display in real-time the 

percentage of ACD Calls, Non ACD Calls, Outgoing calls and Lost calls for a selected item 

(System, group, agent or queue) 

4. Make the settings for the graph you have chosen on step 3 (see the procedures below) 

5. Click the Finish button 

To make the settings for the Horizontal Bar – Agents Status graph: 

1. Select the Agent(s) you want to monitor from the list in Monitor Data section 

 

NOTE: The maximum number of Agents that can be monitored inside a Performance 
Graph is 10. 
2. Set the time division using the Display Time Separator bar or by specifying the number of minutes 

 

3. Select the colors for each Agent state (Idle, Busy, Wrapup, Break, Out of Service, Log Out) by clicking 

on the appropriate field and choosing the color from the color palette 
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To make the settings for the Vertical Bar – Evolution Agent graph: 

1. Select the Agent(s) you want to monitor from the list in Monitor Data section 

2. For the selected Agent choose from the dropdown list containing the ACD Group(s) he is assigned to, 

the ACD Group within you want to monitor the Agent activity 

 

3. Choose the type of the counter you want to monitor from the Counter Category dropdown list 

4. Choose the counter from the Counter Name dropdown list 

 

5. Set the time division using the Display Time Separator bar or by specifying the number of minutes 

6. Click on the Fonts Color tab and select for each item in the Property dropdown list the font type, font 

style and font size in the appropriate fields 

 

7. Select from the Colors section the items you want to be displayed in your graph 
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8. For each selected item on the previous step choose the color to be displayed by clicking on the 

appropriate field and choose the color from the color palette 

 

9. Click on the Others tab and enable the Show Legend option if you want a legend to be displayed in your 

graph, and choose its Placement 

 

10. Optionally, you can set for each Property item in the Borders section the border Style and Width 

 

11. Optionally, you can set the Show Graph Title option to display the Agent name and the ACD Group you 

have chosen at steps 1 and 2 

 

12. Optionally, you can set the Show Additional Description option to display the counter name you have 

chosen at step 4 
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To make the settings for the Vertical Bar Percentage Stacked – Instant Agents graph: 

1. Select the Agent(s) you want to monitor from the list in Monitor Data section 

2. For the selected Agent choose from the dropdown list containing the ACD Group(s) he is assigned to, 

the ACD Group within you want to monitor the Agent activity 

 

3. Click on the Fonts Color tab and select for each item in the Property dropdown list the font type, font 

style and font size in the appropriate fields 

 

4. Select from the Colors section the items you want to be displayed in your graph 
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5. For each selected item on the previous step choose the color to be displayed by clicking on the 

appropriate field and choose the color from the color palette 

 

6. Click on the Others tab and enable the Show Legend option if you want a legend to be displayed in your 

graph, and choose its Placement 

 

7. Optionally, you can set for each Property item in the Borders section the border Style and Width 

 

8. Optionally, you can set the Show Graph Title option to display the Agent name and the ACD Group you 

have chosen at steps 1 and 2 

 

9. Optionally, you can set the Show Additional Description option to display the counter name you have 

chosen at step 4 
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10. Optionally, you can change the refresh time for the graph 

 

To make the settings for the Vertical Bar Percentage Stacked – Evolution Item graph: 

1. Select the type of the item you want to monitor from the Item Type dropdown list 

2. Select the item to be monitored in the Item Name field, according to the selection made on step 1. If you 

want to monitor an Agent, you will have to select the Agent Group 

 

3. Set the time division using the Display Time Separator bar or by specifying the number of minutes in the 

corresponding field 

4. Follow from step 6 from Vertical Bar – Evolution Agent 
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Custom Performance Graph 

To add a new custom performance graph: 

1. Click the New button 

2. Choose the Custom Performance Graph option and click the Next button 

 

3. Choose, according to your preferences, between: 

 Monitor Single Item – the graph will display multiple counters or timer evolution for a single item (which 

you will select on step 5 and 6 between System, Queue, Agent and Group) 

 Monitor Multiple Items – the graph will display single counter or timer evolution for multiple items (which 

you will select on step 5 and 6 between Agents and Groups) 

 Monitor Multiple Items (Multiple Counters) – the graph will display multiple counters or timers evolution 

for multiple items (which you will select on step 5 and 6 between Agents and Groups) 

 

4. Click the Next button 

5. Select from the dropdown list the type of item to be monitored 
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6. Select from the list the item to be monitored 

7. Select from the dropdown list the type of the counter/timer to be monitored (Active, Cumulative or Peak) 

8. Select the counter(s) you want to monitor 

9. Click the Next button 

10. Select the type of chart according to your needs – you can see a preview for each type of chart 

available in the list by selecting it 

 

11. Click the Next button 

12. Choose the font, font style and font size in Fonts section for each item in the Property field 

13. In Colors section, choose (optionally) the color of each item to be displayed (Chart, Title, Footnote, 

Legend, Plot) by checking it and then clicking on the desired color in the color palette 

14. Click the Next button 

15. In Legend section select the Show legend option if you want a legend to be displayed in your graph 

area, and choose its placement 

16. In Other Information section you can enable/disable the Show Graph Title and Show Additional 

Description options and type the text to be displayed in the corresponding fields 

17. Set the Refresh Time by typing the number of seconds you want the data to be refreshed 

18. Click the Finish button 

To modify an existing performance graph double click the graph and the settings window will be 

displayed 

To remove a performance graph select the graph and press the Delete button or press the Delete key 

from the keyboard. 

NOTE:  
The last Performance Graph cannot be deleted. 
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Note: 

When the ACD Report Server is in the Extension Mode (see The Agent Setting section), inside the 

Performance graphs window, for both Predefined Performance Graphs and Custom Performance Graphs 

inside the Agents field you can see the Agents extensions. See below an example picture. 

 

When the ACD Report Server is in the NCV Agent Mode( see The Agent Setting section), inside the 

Performance graphs window, for both Predefined Performance Graphs and Custom Performance Graphs 

inside the Agents field you can see the Agents names (defined in the Agents Data window). See below an 

example picture. 

 

NOTE:  
When the Server is disconnected, check the network and restart the Client. 
In Agent Mode only the logged-in Agents are displayed. 
In Agent Mode, if the Agent is logout or the Agent name is changed the graph settings 
need to be set again. 
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Generating Reports 

ACD Reports 
The ACD Reports provides various call statistics for the requested time period.    

The reporting feature of ACD Client application allows generating multiple types of custom reports. 

If desired, you can schedule a number of reports for automatic printing. In addition to the automatic printing, 

it is also possible to print out the desired report whenever is required. 

To access the ACD Reports window click on the ACD Reports button in the Views>ACD window, or from 

the main menu View>Go to>ACD>ACD Reports. 

 

You can choose from a list of report types from the ACD Reports window, which you can customize 

according to the information you need to achieve: 

 CO Call Report – lists all calls monitored from either all CO trunks or a group of trunks identified by the 

same DDI/DID/MSN during a user selected time period 

 System Report – provides summary information accumulated on the user selected time period 

regarding all Agents activity; information is grouped according to the selected time division. ).  

 Group Report – provides information accumulated on the user selected time period regarding all 

Agents activity for the user specified ACD Group(s).  

 Agent Report - provides information accumulated on the user selected time period for the user 

selected Agent(s). The report displays information about each incoming call handled by every Agent. 
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For each extension the report contains the information for each group that it is assigned to. The 

information is grouped according to the selected time division.  

 Agent ID based Report - provides the summary information for the user specified Agents accumulated 

during the user specified time period. The Agent ID Based Report is only available in the NCV Agent 

Mode. 

Generating a report 

To generate a report follow the steps bellow: 

1. Select the report from the reports list 

2. Choose the report settings: the information fields, the filtering criteria, date selection, paper format, etc.  

3. Click on the  Create Report button. 

 

 



 

Client Software Installation Manual           75  

You can show/ hide the Report Properties control area by clicking on the specific button. The Report 

Properties area is presented below. 

 

You can also show/ hide the Scheduled Reports control area by clicking on the specific button. The 

Scheduled Reports area is presented below. 

 

This section covers the following topics: 

1. CO Call Report 

2. System Report 

3. Group Report 
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4. Agent Report 

5. AgentID based Report 
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CO Call Report 

Description 

CO Call Report lists all calls monitored from either all CO trunks or a group of trunks identified by the same 

DDI/DID/MSN during a user selected time period (based on the information from Call Log – CO Based). 

 

Choosing report fields  

1.  Select the CO Call Report from the left pane reports list 

2. Click the Field Chooser button. A Field Chooser window will be displayed (for Portrait orientation the 

maximum number of Chosen fields is 7 and for Landscape is 9) 

 

3. Enable or disable the fields, use the arrows to change the fields order 
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 ANI – Automatic Number Identification 

 Call Duration – the total time spent in the system from the moment the call entered until it exits the 

system 

 Call Log Id – every call the system handles receives an ID number 

 Caller Id – the customer phone number 

 Caller Name – available only if it is received from the CO  

 Completion Time – the moment of time the call was ended 

 Customer – displays the full customer name (First, Middle and Last) 

 Date/Time – displays the date and time the call arrived in the ACD Queue or the Agent 

 DDI/DID/MSN – the DDI/DID/MSN data (number) from the public exchange (CO) 

 Dialed Number – the number the customer dialed 

 DNIS – Dialed Number Identification Service 

 Hold Time – the total time a call was placed on hold by the Agent 

 Incoming/Outgoing – type of call 

 Number of Overflowed – the number of times the call was transferred because of overflow. Overflow 

Queuing Busy is not supported. 

 Number of Conference – a conference is a call with at least 3 participants. Number of Conference 

increases every time when a call changes from 2 to 3 participants. 

 Number of No Answered – the number of times the call wasn't answered 

 Number of Transferred – the number of times the call was transferred from one Agent to another 

extension (Agent) or ICD Group 

 Queue Time – the period of time spent waiting in the ACD Queue 

 Ring Time – the length of time the Agent extension has rang while the call has been left unanswered 

 Status – displays the call status (ACD, Non ACD, Lost ACD, Abandoned, Out) 

 Talk Time – the length of time the call was in conversation with Agents 

 Trunk – the CO line number 

  Wait Time – the length of time the call waited in the ACD Queue and rang at Agent (Queue Time + 

Ring Time) used for that call 

4. Click on the OK button to save the configuration.  
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Filtering the report information 

The filtering criteria are displayed on the first page of the report.  

1. Select the CO Call Report from the left pane reports list 

2. Click the Filter… button. The Call Advanced Filter window will be displayed 

3. Select the desired filtering criteria. Select one or more parameters according to your needs. 

 

 Agents – select the desired agents in the dropdown list. In this case you will see in your report the 

information only for the calls handled by the selected agents 

 ACD Groups – select the desired groups from the dropdown list. In this case you will see in your report 

the information related on the calls handled by the specified ACD Groups 

 Extensions – select the desired extension from the dropdown list. In this case your report will provide 

information on the calls handled only by the specified extension 

 Ring Time(s) is – select a condition for this parameter (for example – choose from the dropdown list 

Greater and type a value – 20 for example. In this case you get the information on the calls that rang for 

more than 20 seconds).  

 Wait Time(s) is – select a condition for this parameter 

 Talk Time(s) is – select a condition for this parameter 

 Hold Time(s) is – select a condition for this parameter 

 Call Status is – select the type of the call status you want to filter with 
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4. Click on the Next button to see the additional filtering criteria 

 

 Customer is – fill-in with the desired customer name (the Customer Name stored in the internal 

database, set in the Customer Data section) 

 Caller ID is – fill-in with the appropriate information of the desired customer (the Caller ID stored in the 

internal database, set in the Customer Data section) 

 Caller Name is – fill in with the desired Caller Name 

 CO (Trunk) is – fill-in with the desired trunk number (CO line number used for that call)  

 Dialed number is – fill-in with the desired number (the number the customer dialed) 

 DDI/DID/MSN is – the DDI/DID/MSN data (number) from the public exchange (CO) 

 Transferred is – select Yes or No 

 Conference is – select Yes or No 

 No Answer is – select Yes or No 

 Incoming/Outgoing is – select the type of call 

5. Click the Finish button to save your configuration 

Time division 

No time division/ Hour/ Day/ Week/ Month 

Time range 

Today/ This week/This month/Custom Interval 
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Report sample 
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Note: 

When the ACD Report Server is in the Extension Mode (see The Agent Setting section), inside the Call 

Advanced Filter, in the Agents field nothing will appear 

 

When the ACD Report Server is in the NCV Agent Mode (see The Agent Setting section), inside the Call 

Log Advanced Filter, in the Agents field you can see the Agents names (defined in the Agents Data 

window). 
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System Report 

Description 

System Report provides summary information accumulated on the user selected time period regarding all 

Agents activity; information is grouped according to the selected time division.  

 

Fields list 

 Incoming ACD Calls – the total number of ACD calls delivered to all the Agents  

 Answered Calls – the total number of ACD calls that were answered by all the Agents  

 Not Answered ACD Calls – the total number of calls that were transferred to the No Answer 

destination  

 Overflowed ACD Calls – the total number of calls that were delivered to the Overflow No Answer 

destination due to an overflow no answer condition  

 Lost ACD Calls – the total number of ACD Calls that were lost  

Chart description 

The pie chart is based on the percentages of the number of Incoming ACD Calls in each group from Total 

Incoming ACD calls on all groups. 

The percentage for one Group is calculated using the following formula: 

(Incoming ACD Calls to the Group)*100/(Total Incoming ACD Calls to all Groups) 

Filtering the report information 

The filtering criteria are displayed on the first page of the report.  

1. Select the System Report from the left pane reports list 
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2. Enable the Filter checkbox and choose from the dropdown list the desired ACD Group(s) 

Time division 

No time division/ Hour/ Day/ Week/ Month 

Time range 

Today/ This week/This month/Custom Interval 

Report sample 
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Group Report 

Description 

Agent Group Report provides information accumulated on the user selected time period regarding all Agents 

activity for the user specified ACD Group(s). 

 

Fields list 

 Incoming ACD Calls – total number of ACD calls delivered to the Group  

 Answered Calls – total number of ACD calls that were answered by all the Agents within that Group 

 Not Answered ACD Calls  – the total number of calls for that Group that were transferred to the No 

Answer destination  

 Overflowed ACD Calls – the total number of calls for that Group that were delivered to the Overflow 

No Answer destination due to an overflow no answer condition  

 Lost ACD Calls – the total number of ACD Calls for that Group that were lost  

Filtering the report information 

The filtering criteria are displayed on the first page of the report.  

1. Select the System Report from the left pane reports list 

2. Enable the Filter checkbox and choose from the dropdown list the desired ACD Group(s) 

Chart description 

The pie chart is based on the percentages of the number of Incoming ACD Calls in each group from Total 

Incoming ACD Calls on all groups. 

The percentage for one Group is calculated using the following formula: 
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(Incoming ACD Calls to the Group)*100/(Total Incoming ACD Calls to all Groups) 

Time division 

No time division/ Hour/ Day/ Week/ Month 

Time range 

Today/ This week/This month/Custom Interval 

Report sample 
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Agent Report  

Description 

Agent Report provides information accumulated on the user selected time period for the user selected 

Agent(s). The report displays information about each incoming call handled by every Agent. For each 

extension the report contains the information for each group that it is assigned to. The information is 

grouped according to the selected time division.  

 

NOTE: The Login date of the Agent must be included in the selected time range for 
correct reporting. Please login/logout Agent on group(s) at least once per day for Agent 
Reports to be consistent. 

Fields list 

For each Agent, the report will contain the following fields (for all groups that Agent is assigned to): 

 Total Incoming ACD Calls – total number of ACD calls delivered to the Agent 

 Total Incoming Non ACD Calls – total number of Non ACD calls delivered to the Agent 

 Total Incoming Calls – total number of incoming calls delivered to the Agent 

 Total Answered Calls – total number of ACD and Non ACD calls that were answered by the Agent 

 Total Answered Non ACD Calls - total number of Non ACD calls that were answered by the Agent 

 Total Lost Calls – total number of calls that were lost by the Agent (the calling party hanged up or if the 

call was delivered to another destination due to an overflow no answer condition) 

 Login Time – the login date of the Agent 

 Logout Time – the logout date of the Agent 

 Busy Time – the total length of time the Agent within a Group was Busy 

 Break Time – the total length of time the Agent within a Group was in Break 

 Idle Time – the total length of time the Agent within a Group was Idle 
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 Wrapup Time – the total time spent by the Agent within a Group on Wrapup activities 

Chart description 

The pie chart is based on the percentages of the number of Incoming Calls for each Agent from Total 

Incoming calls for all the Agents. 

The percentage for one Agent is calculated using the following formula: 

(Incoming Calls to the Agent)*100/(Total Incoming Calls to all Agents). 

Filtering the report information 

The filtering criteria are displayed on the first page of the report.  

1. Select the Agent Report from the left pane reports list 

2. Click the Filter… button. The Agent Log Advanced Filter window will be displayed 

NOTE: The Filter works for Agent login sessions, not for cumulated values. 
3. Select the desired filtering criteria. Select one or more parameters according to your needs. 

 

 Agents – select the desired agents in the dropdown list (by extension or by name). In this case you will 

see in your report the information only for the calls handled by the selected agents 

 ACD Groups – select the desired groups from the dropdown list. In this case you will see in your report 

the information related on the calls handled by the specified ACD Groups 

 Extensions – select the desired extension from the dropdown list. In this case your report will provide 

information on the calls handled only by the specified extension 

 Login Duration (s) is – select a condition for this parameter 

 Busy Time (s) is – select a condition for this parameter 

 Break Time (s) is – select a condition for this parameter 

 Idle Time (s) is – select a condition for this parameter 
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 Wrapup Time (s) is – select a condition for this parameter 

4. Click on the Next button to see the additional filtering criteria 

 

 Total Incoming ACD Calls – refers to the number of the Incoming ACD Calls (the total number of ACD 

calls delivered to the Agent.) 

 Total Incoming Non ACD Calls – refers to the number of the Incoming Non ACD Calls (the total 

number of Non ACD calls delivered to the Agent) 

 Total Answered Non ACD Calls – refers to the number of the Answered Non ACD Calls (total number 

of Non ACD calls that were answered by the Agent) 
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5. Click on the Next button to see the additional filtering criteria 

 

 Total Incoming Calls – refers to the number of the Total Incoming Calls (the total number of calls 

delivered to the Agent.) 

 Total Lost Calls – refers to the number of the Total Lost Calls (the total number of calls lost by the 

Agent) 

 Total Answered Calls – refers to the number of the Total Answered Calls (the total number of calls 

answered by the Agent) 

6. Click the Finish button to save your configuration 

Time division 

No time division/ Hour/ Day/ Week/ Month 

Time range 

Today/ This week/This month/Custom Interval 
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Report sample 
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Note: 

When the ACD Report Server is in the Extension Mode (see The Agent Setting section), inside the Agent 

Log Advanced Filter window in the Agents field you can see the Agents extensions 

 

When the ACD Report Server is in the NCV Agent Mode (see The Agent Setting section), inside the Agent 

Log Advanced Filter window in the Agents field you can see the Agents names (defined in the Agents Data 

window). 
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AgentID based Report  

Description 

The AgentID based Report allows you to exactly monitor each Agent activity; the ID number is unique for 

each Agent. AgentID based Report provides information accumulated on the user selected time period for 

the user selected Agent(s) ID without regard of the used extensions and login group. The information is 

grouped according to the selected time division.  

The AgentID based Report displays the total value for all the displayed fields (for all the log in sessions 

during the selected time period). 

 

Fields list 

For each Agent, the report will contain the following fields (for all groups that Agent is assigned to): 

 Total Incoming ACD Calls – the total number of ACD calls delivered to the Agent. 

 Total Incoming Non ACD Calls – the total number of Non ACD calls delivered to the Agent.  

 Total Incoming Calls – the sum of Incoming ACD Calls and Incoming Non ACD Calls (the 2 fields 

described above). 

 Total Answered Calls – the total number of ACD and Non ACD calls that were answered by the Agent. 

 Total Answered Non ACD Calls – the total number of Non ACD calls that were answered by the 

Agent. 

 Total Lost Calls – the total number of calls that were lost by the Agent (the calling party hanged up or if 

the call was delivered to another destination due to an overflow no answer condition). 

 Login Duration – the total length of time the Agent within a Group was logged in 

 Busy Time – the total length of time the Agent within a Group was Busy 

 Break Time – the total length of time the Agent within a Group was in Break 
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 Idle Time – the total length of time the Agent within a Group was Idle 

 Wrapup Time – the total time spent by the Agent within a Group on Wrapup activities 

Chart description 

The pie chart is based on the percentages of the number of Incoming Calls for each Agent from Total 

Incoming calls for all the Agents. 

The percentage for one Agent is calculated using the following formula: 

(Incoming Calls to the Agent)*100/(Total Incoming Calls to all Agents). 

Filtering the report information 

The filtering criteria are displayed on the first page of the report.  

1. Select the Agent Report from the left pane reports list 

2. Click the Filter… button. The Agent Log Advanced Filter window will be displayed 

NOTE: The Filter works for Agent login sessions, not for cumulated values. 
3. Select the desired filtering criteria. Select one or more parameters according to your needs 

 

 Agents – select the desired agents in the dropdown list (by extension or by name). In this case you will 

see in your report the information only for the calls handled by the selected agents 

 ACD Groups – select the desired groups from the dropdown list. In this case you will see in your report 

the information related on the calls handled by the specified ACD Groups 

 Extensions – select the desired extension from the dropdown list. In this case your report will provide 

information on the calls handled only by the specified extension 
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 Login Duration (s) is – select a condition for this parameter 

 Busy Time (s) is – select a condition for this parameter 

 Break Time (s) is – select a condition for this parameter 

 Idle Time (s) is  - select a condition for this parameter 

 Wrapup Time (s) is – select a condition for this parameter 

4. Click on the Next button to see the additional filtering criteria 

 

 Total Incoming ACD Calls – refers to the number of the Incoming ACD Calls (the total number of ACD 

calls delivered to the Agent.) 

 Total Incoming Non ACD Calls – refers to the number of the Incoming Non ACD Calls (the total 

number of Non ACD calls delivered to the Agent.) 

 Total Answered Non ACD Calls – refers to the number of the Answered Non ACD Calls (total number 

of Non ACD calls that were answered by the Agent) 
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5. Click on the Next button to see the additional filtering criteria 

 

 Total Incoming Calls – refers to the number of the Total Incoming Calls (the total number of calls 

delivered to the Agent.) 

 Total Lost Calls – refers to the number of the Total Lost Calls (the total number of calls lost by the 

Agent) 

 Total Answered Calls – refers to the number of the Total Answered Calls (the total number of calls 

answered by the Agent) 

6. Click the Finish button to save your configuration 

Time division 

No time division/ Hour/ Day/ Week/ Month 

Time range 

Today/ This week/This month/Custom Interval 

NOTE: The Login date of the Agent must be included in the selected time range for 
correct reporting. Please login/logout Agent on group(s) at least once per day for Agent 
Reports to be consistent. 
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Report sample 
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Making the report settings 

All the settings described below will be applied to the selected report in the list. 

To select the time division choose from: 

 Hour – the information is grouped by hours (for example 10:00 AM, 11:00AM etc.) 

 Day – The information is grouped by days 

 Week – The information is grouped by weeks 

 Month – The information is grouped by months 

 No time division – The information is not grouped by time units 

To set the period of time the report will be generated choose in the Report Date Selection section 

between Today, This week, This month or Custom Interval. 

If you choose a Custom Interval, you will have to set the Start Date/Time and End Date/Time, too. 

 

To generate a chart in your report, according to your report settings, set the Chart on option (System 

report, Group Report, Agent Report and AgentID based Report) 

To select your report paper size, choose between Letter and A4 in the Paper Size field. 

 

To select your report paper orientation, choose between Portrait and Landscape in the Orientation field. 

(CO Call Report, Agent Report and AgentID based Report) 
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In Schedule Options section you can set the time you want the scheduled report to be 

printed/exported/emailed. 

 

NOTE: The maximum number of reports that can be added to schedule is 21. 

To set the time for the scheduled report you can choose between: 

 Hourly at minute – the report will be printed/exported/emailed every hour at the minute specified in the 

corresponding field 

 Daily at time – the report will be printed/exported/emailed every day at the time specified in the 

corresponding field 

 Weekly – you have to specify the day of the week as well as the time of the day the report will be 

printed/exported/emailed, in the appropriate fields 

 Custom Interval – specify the interval (in hours or days) and the time the report will be 

printed/exported/emailed  

To add a report to schedule: 

1. Select the report from the reports list 

2. Make the desired settings 

3. Click on the Add to Schedule button 

To export the report and save it to a file: 

1. Select the report from the reports list 

2. Make the desired settings 

3. Select the Export data in option 

4. Click the  button and open the file where you want the report to be saved 

NOTE: The date format for the Excel [xls] and Data Interchange Format [DIF] are not 
same as the date format in the Basic Settings. Please change the date format when you 
open them with application. 
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To send the report by e-mail: 

NOTE: Before using this feature you need to fill in all the Email Server from Reports 
fields from Basic Settings 
1. Select the report from the reports list 

2. Make the desired settings 

3. Enable the Send report to mail option 

4. Type the e-mail address where you want the report to be sent, in the appropriate field  

5. Click on the Add to Schedule button 

The Scheduled Reports section also provides you with information on the added to schedule reports. 

You can see the settings you have made for the scheduled reports: 

 Report – the chosen report type 

 Scheduled Info – the settings you have made in Schedule Option section 

 Destination – the location where the report is exported (or the printer used to print), according to the 

schedule settings 

 

NOTE: For an ACD Report can be set one, two, or all of the Print, Export, and Send to 
mail options at a time, in any combination. 

Changing the logo picture in the report 

The Client application allows you to set your own logo on the ACD Reports. The supported formats are bmp 

and jpeg. 

To change the logo picture: 

1. Go to: File> Change Logo or click on the  Change Logo button  

2. Browse and select the picture you want to set as logo 

3. Click on the Open button 

Now, on every report you create the logo picture you have selected will appear. 
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To change the settings for a scheduled report 

1. Double-click the report name from the list. The Scheduled Report Properties window will be displayed 

 

2. Select the Report Properties tab and you can make changes the items to be included in the report using 

the Filter button. Also you can change the Time Division, the Report date selection and the Paper 

Format 

3. Select the Schedule Options tab and you can change the schedule options 

4. Click Apply to save the changes  

Saving a report 

1. Make the desired settings for the report 

2. Click the Create Report button. The Report Viewer window will be displayed 
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3. In the Report Viewer window choose the  Export Report button 

4. Choose the format and destination of the report (select from the dropdown list Disk file to save the 

report on disk) 

 

5. Choose the export options, you can save all the report pages or just a part of the report 

 

6. Choose the destination where to save the report 

 

7. Click on the Save button. 

NOTE: The date format for the Excel [xls] and Data Interchange Format [DIF] are not 
same as the date format in the Basic Settings. Please change the date format when you 
open them with application. 
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Call Log 

Viewing Call Log Information 
To view call log information click the Call Log button in the Views>ACD window, or from the main menu 

View>Go to>ACD>Call Log. 

You have two options here: 

 CO Based – a list of call log information based on Customer data. 

 Agent Based - a list of call log information based on the Agent data.  

The Lost calls are highlighted in red. 

NOTE: During the NCV Agent Mode the Agent Name field shows the Agent name 
associated with the Agent ID, during the Extension Mode the Agent Name field shows 
the extension name defined in the PBX. 

 

In the table below you can see the main operations you can perform: 

Item Description 

Lookup field Used to search a particular Agent, Group, Customer etc. Choose 
from the list the field in order to perform search, and type a part or 
the whole name for the desired information 
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<enter lookup key> Fill-in with the particular information of the searched item according 
to the chosen Lookup field. 

Refer to the table bellow for further explanations. 

The  Find button 
After you choose the Lookup field and enter the lookup key, click 
this button  

The  Refresh button 
Use this button to refresh the information displayed 

The Filter… button 
Use this button to choose filtering criteria for the displayed data 

The  Field Chooser 
button 

Use this button to select the visible fields 

The  Clear button 
Use this button to delete the information, you can choose to: 

Delete from the List – the records will be erased from the list, but 
they are still stored in the database 

Delete from the Database – all the records displayed in the list will 
be erased from the database 

The  Export button 
Use this button to save the information; the file type is .csv (comma 
separated values). 

The files with the format of csv(comma separated values) are easily 
viewed and managed with applications for data in columnar format, 
for example applications for spreadsheets or databases. 

In the table bellow you can see explanations about the look up fields for Call Log - CO Based:  

Field Look up key 

Customer Any alphanumeric string or substring (e.g. John or Joh) 

Caller ID Any numeric string or substring (e.g. 5553535 or 555) 

Caller Name Any alphanumeric string or substring (e.g. John or Joh) 

Dialed Number Any numeric string or substring 

Trunk Any numeric string or substring 

DDI/DID/MSN Any numeric string or substring 

DNIS Any numeric string or substring 

ANI Any numeric string or substring 

Date/Time Use the given format for Date/Time (M/d/yyyy h:mm:ss tt) 

Date Use the given format for Date (M/d/yyyy) 

Time Use the given format for Time (h:mm:ss tt) 

Year Any numeric string 

Month Any numeric string 

Day Any numeric string 

Ring Time (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Queue Time (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 
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Talk Time (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Wait Time (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Hold Time (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Call Duration (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Number of Overflowed Any numeric string 

Number of No Answered Any numeric string 

Number of Transferred Any numeric string 

Number of Conference Any numeric string 

In the table bellow you can see explanations about the look up fields for Call Log - Agent Based: 

Field Look up key 

Agent Name Any alphanumeric string or substring (e.g. John or Joh) 

Group Name Any alphanumeric string or substring 

Extension Any numeric string or substring (e.g. 1001 or 01) 

Customer Any alphanumeric string or substring 

Caller ID Any numeric string or substring  

Caller Name Any alphanumeric string or substring 

Dialed Number Any numeric string or substring 

Trunk Any numeric string or substring 

DDI/DID/MSN Any numeric string or substring 

DNIS Any numeric string or substring 

ANI Any numeric string or substring 

Date/Time Use the given format for Date/Time (M/d/yyyy h:mm:ss tt) 

Date Use the given format for Date (M/d/yyyy) 

Time Use the given format for Time (h:mm:ss tt) 

Year Any numeric string 

Month Any numeric string 

Day Any numeric string 

Ring Time (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Talk Time (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Queue Time (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Wait Time (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 
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Hold Time (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Call Duration (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Agent ID Any numeric string or substring 

When you select a call from the list, more information about that call can be seen in the lower half of the Call 

Log – CO Based window. 

NOTE: If in the PBX the Distribution algorithm is set to Ring All for a group, then the 
Agent Name field will be All if the call is lost. 

To choose the call log CO Based information fields to be displayed: 

1. Click the CO Based tab 

2. Click the Field chooser button. The Select visible fields window will be displayed 

 

3. Select the desired fields in the CallLog CO Fields section, from the following: 

 Call Log ID – every call the system handles receives an ID number 

 Date/Time – displays the date and time the call arrived in the ACD Queue or the Agent 

 Completion Time – the time the call was completed 

 Customer  – displays the full customer name (First, Middle and Last) 

 Caller ID – the customer phone number 

 Dialed Number – the number the customer dialed 

 DDI/DID/MSN – the DDI/DID/MSN data (number) from the public exchange (CO) 

 Trunk – CO line number used for that call 

 Incoming/Outgoing – type of call 

 Status - displays the call status  

 Caller Name – available only if it is received from the CO  

 DNIS – Dialed Number Identification Service 
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 ANI – Automatic Number Identification 

 Talk Time – the length of time the call was in conversation with Agents 

 Wait Time – the length of time the call waited in the ACD Queue and rang at Agent (Queue Time + 

Ring Time) 

 Hold Time - the total time a call was placed on hold by the Agent 

 Ring Time – the length of time the Agent extension has rang while the call has been left unanswered 

 Queue Time – the period of time spent waiting in the ACD Queue 

 Call Duration – the total time spent in the system from the moment the call entered until it exits the 

system 

 Number of Overflowed - the number of times the call was transferred because of overflow. Overflow 

Queuing Busy is not supported. 

 Number of No Answered – the number of times the call wasn't answered 

 Number of Transferred – the number of times the call one Agent transferred the call to another 

extension (Agent) or ICD Group 

 Number of Conference – a conference is a call with at least 3 participants. Number of Conference 

increases every time when a call changes from 2 to 3 participants. 

4. Select in the Call Log Agent Fields section, the call log extended information fields that will be displayed 

in the bottom of the window, from the following: 

 Call Log ID - every call the system handles receives an ID number 

 Date/Time – displays the date and time the call arrived in the ACD Queue or the Agent 

 Completion Time – the time the call was completed 

 Agent Name - the name of the Agent that handled the call 

 Group Name - the group name 

 Extension - the extension number 

 Ring Time – the length of time the Agent extension has rang while the call has been left unanswered 

 Talk Time – the length of time the call was in conversation with Agents 

 Wait Time – the total time that the call waits until it is answered  (speed of answer) 

 Hold Time - the total time a call was placed on hold by the Agent 

 Queue Time – the period of time spent waiting in the ACD Queue 

 Transferred – select Yes or No 

 No Answer – select Yes or No 

 Conference – select Yes or No 

 Group Overflowed From - only if the call overflowed from another ACD Group 

 Agent No Answer From - only in case that the call wasn’t answered by the Agent it was delivered to, 

and it was transferred to the No Answer Destination 
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 Extension No Answer From – the extension number of the Agent the call was transferred from in case 

of No Answer 

 Agent Transferred From – the name of the Agent that transferred the call 

 Extension Transferred From – the extension number of the Agent that made the transfer 

 Agent Transferred To – the name of the Agent the call was transferred to 

 Extension/Dialed Number Transferred To – the extension or the dialed number the call was 

transferred to 

 Extension/Dialed Number Conference – the extension or the dialed number for the conference 

 Agent ID – the Agent ID number (available only for NCV Agent Mode) 

5. Click OK to enable your configuration 

Note: 

During the NCV Agent Mode the Agent ID field is available from the Select visible fields – CallLog Agents 

Fields, see the picture bellow. 
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To choose the call log Agent Based information fields to be displayed: 

1. Click the Agent Based tab 

2. Click the Field Chooser button. The Select visible fields window will be displayed 

 

3. Select the desired fields in the CallLog Fields section. For the description of each field see the previous 

procedure 

4. Click OK to save your settings 
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Filtering the Call Log information 
You may not need to see all the call log information. In that case, you can filter the data according to your 

preferences, for both CO and Agent Based (for example, if you want to see the call log information for two 

particular ACD Groups during a specified period of time). 

To choose the filtering criteria for the call log information: 

1. Click the Filter… button. The Call Log Advanced Filter window will be displayed 

 

2. Enable the filtering keys according to your needs. You have the following options: 

 Agents – select the desired agents in the dropdown list. In this case you will see the information only 

for the calls handled by the selected agents 

 ACD Groups – select the desired groups from the dropdown list. In this case you will see  the 

information related on the calls handled by the specified ACD Groups 

 Extensions – select the desired extension from the dropdown list. In this case you will see the 

information on the calls handled only by the specified extension 

 Ring Time(s) is– select a condition for this parameter (for example – choose from the dropdown list 

Greater and type a value – 20 for example. In this case you get the information on the calls that rang for 

more than 20 seconds) 

 Wait Time(s) is – see the description of the Ring Time parameter 

 Talk Time(s) is – see the description of the Ring Time parameter 

 Hold Time(s) is – see the description of the Ring Time parameter 

 Call Status is – select the type of the call status you want to filter with 

 Start Date/Time – select the start date and time for the beginning of the period you want the 

information to be displayed 
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 End Date/Time – select the end date and time for the end of the period you want the information to be 

displayed 

3. Click the Next button 

 

4. Optionally, enable the desired additional filter(s) which you can see in the Call Advanced Filter 

Additional window: 

 Customer is – displays the full customer name (First, Middle and Last) 

 Caller ID is– fill-in with the appropriate information of the desired customer (the Caller ID stored in the 

internal database, set in the Customer Data section) 

 Caller Name is – fill in with the desired Caller Name 

 CO (Trunk) is – fill-in with the trunk number (CO line number used for that call)  

 Dialed number is – the number the customer dialed 

 DDI/DID/MSN is – the DDI/DID/MSN data (number) from the public exchange (CO) 

 Transferred is – select Yes or No 

 Conference is – select Yes or No 

 No Answer is – select Yes or No 

 Incoming/Outgoing is – type of call 

5. Click the Finish button to perform the operation 

Filtering Note 

When you select more than one filtering criteria, for example Ring Time is Greater 60 and Talk Time is 

Less 120, only the information about the calls that have both Ring Time is Greater 60 and Talk Time is 

Less 120 will be displayed. If no calls fulfill the selected conditions no information will be displayed. 
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Managing Call Log Information 

Here you can find the instructions for performing the following operations on the call log information: 

 Exporting to a specified file 

 Deleting records 

To export the data to a file: 

1. Click the Export button. The Save as window will be displayed 

2. Browse for the file or folder where you want the information to be saved. Type the file name in the 

appropriate field. The file type is .csv (comma separated values) 

3. Click the Save button to finish the operation 

To delete the displayed information: 

1. Click the Clear button 

2. You can choose to: 

 Delete from the List – the records will be erased from the list, but they are still stored in the database 

 Delete from the Database – all the records displayed in the list will be erased from the database 
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Agent Log 

Viewing Agent Log Information 
This tool allows you to see all log-in/log-out information for the Agents. 

To access the Agent Log window click on the Agent Log button from the Views>ACD window, or choose 

from the main menu View>Go to>ACD>Agent Log 

For a logged-in Agent the Logout Date/Time filed is Not Logged Out. 

NOTE: During the NCV Agent Mode the Agent Name field shows the Agent name 
associated with the Agent ID, during the Extension Mode the Agent Name field shows 
the extension name defined in the PBX. 

 

Item Description 

Lookup field Used to search a particular Agent, Group, Customer etc. Choose 
from the list the field in order to perform search, and type a part or 
the whole name for the desired information 
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<enter lookup key> Fill-in with the particular information of the searched item according 
to the chosen Lookup field. 

Refer to the table bellow for further explanations. 

The  Find button 
After you choose the Lookup field and enter the lookup key, click 
this button  

The  Refresh button 
Use this button to refresh the information displayed 

The Filter… button 
Use this button to choose filtering criteria for the displayed data 

The  Field Chooser 
button 

Use this button to select the visible fields 

The  Clear button 
Use this button to delete the information, you can choose to: 

Delete from the List – the records will be erased from the list, but 
they are still stored in the database 

Delete from the Database – all the records displayed in the list will 
be erased from the database 

The  Export button 
Use this button to save the information, the file type is .csv (comma 
separated values). 

The files with the format of csv(comma separated values) are easily 
viewed and managed with applications for data in columnar format, 
for example applications for spreadsheets or databases. 

In the table bellow you can see explanations about the look up fields: 

Field Look up key 

Login Date Use the given format for Date (M/d/yyyy) 

Logout Date Use the given format for Date (M/d/yyyy) 

Agent Name Any alphanumeric string or substring (eg. John or Joh) 

Group Name Any alphanumeric string or substring 

Extension Any numeric string or substring (e.g. 1001 or 01) 

Login Duration (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Break Time (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Busy Time (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Idle Time (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Wrapup Time (s) Any numeric string (the total number of seconds you are searching 
for, no matter of Timers Format Options value) 

Total Incoming ACD Calls Any numeric string 

Total Incoming Non ACD Calls Any numeric string 

Total Answered Non ACD Calls Any numeric string 

Total Incoming Calls Any numeric string 

Total Lost Calls Any numeric string 
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Total Answered Calls Any numeric string 

Agent ID Any numeric string or substring 

 

To choose the information fields you want to be displayed click the Field Chooser button and select in 

the Select Visible Fields window from the following parameters: 

 

 LogIn Date/Time 

 LogOut Date/Time 

 Agent Name – the Agent Name 

 Group Name – the Group Name 

 Extension – the extension number 

 Login Duration – the total length of time the Agent was logged in 

 Break Time – the total length of time the Agent was in the Break 

 Busy Time – the total length of time the Agent was Busy 

 Idle Time – the total length of time the Agent was Idle 

 Wrapup Time – the total time spent by the Agent on Wrapup activities 

 Total Incoming ACD Calls – the total number of ACD calls delivered to the Agent 

 Total Incoming Non ACD Calls - the total number of Non ACD calls delivered to the Agent 

 Total Answered Non ACD Calls – the total number of Non ACD calls answered by the Agent 

 Total Incoming Calls – the total number of calls delivered to the Agent 

 Total Lost Calls – the total number of calls hung up by the calling party before the Agent to answer 

 Total Answered Calls – the total number of calls answered by the Agent 
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 Agent ID – the Agent ID number (available for the NCV Agent mode) 
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Filtering Agent Log Information 
To choose the filtering criteria for the agent log information: 

1. Click the Filter… button. The Agent Log Advanced Filter window will be displayed 

 

2. Enable the filtering keys according to your needs. You have the following options: 

 Agents – select the desired agents in the dropdown list. In this case you will see the information only 

for the calls handled by the selected agents 

 ACD Groups – select the desired groups from the dropdown list. In this case you will see the 

information related on the calls handled by the specified ACD Groups 

 Extensions – select the desired extension from the dropdown list. In this case you will see the 

information on the calls handled only by the specified extension 

 Login Duration (s) is – select a condition for this parameter (for example – choose from the dropdown 

list Greater and type a value – 20 for example. In this case you get the information on the agents logged 

in for more than 20 seconds) 

 Busy Time(s) is – select a condition for this parameter (for example – choose from the dropdown list 

Greater and type a value – 20 for example. In this case you get the information on the agents that were 

busy for more than 20 seconds) 

 Break Time(s) is – see the description of the Busy Time parameter 

 Idle Time(s) is – see the description of the Busy Time parameter 

 Wrapup Time(s) is – see the description of the Busy Time parameter 

 Start Date/Time – select the start date and time of the period you want the information to be displayed 

 End Date/Time – select the end date and time of the desired period  
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3.  Click the Next button 

 

4. Optionally, enable the desired additional filter(s) which you can see in the Agent Log Advanced Filter 

Additional window: 

 Total Incoming ACD Calls – refers to the number of the Incoming ACD Calls 

 Total Incoming Non ACD Calls – refers to the number of the Incoming Non ACD Calls 

 Total Answered Non ACD Calls – refers to the number of the Answered Non ACD Calls 

5. Click the Next button 

6. Optionally, enable the desired additional filter(s) which you can see in the Agent Log Advanced Filter 

Additional window: 
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 Total Incoming Calls – refers to the number of the Total Incoming Calls 

 Total Lost Calls - refers to the number of the Total Lost Calls 

 Total Answered Calls - refers to the number of Total Answered Calls 

7. Click the Finish button to perform the operation 

Filtering Note 

When you select more than one filtering criteria, for example Busy Time (s) is Greater 120 and Total 

Incoming Calls Greater 5, only the information about the calls that have both Busy Time (s) is Greater 

120 and Total Incoming Calls Greater 5 will be displayed. If no Agents fulfill the selected conditions no 

information will be displayed. 
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Appendix – Counters and Timers 

ACD System 

ACD System Active Counters 
An active counter monitors the appropriate items that are being handled by the system at that very moment. 

Name Description Supplementary Explanation 

Current Incoming 
Calls 

The total number of incoming calls currently being 
handled by the system 

(Current ACD Calls) + (Current 
Incoming Non ACD Calls) 

Current ACD Calls The total number of ACD calls currently being 
handled by the system 

 

Current Incoming 
Non ACD Calls  

The total number of Non ACD calls currently being 
handled by the system 

Calls to Agent via CO 

Waiting Calls  The total number of incoming calls (ACD and Non 
ACD) that are currently waiting 

 

Waiting ACD Calls The total number of ACD calls that are currently 
waiting for answer 

 

Waiting ACD Calls 
In Queue  

The number of ACD calls that are currently in Queue Queue Active (ACD Calls In 
Queue) 

Active Answered 
Calls  

The total number of active answered calls (ACD and 
Non ACD) 

ACD and Non ACD calls 

Current Outgoing 
Calls 

The number of active outgoing calls  

Log In Agents  The total number of Agents that are currently logged-
in the system 

 

Log Out Agents  The total number of Agents that are currently logged-
out from the system 

 

ACD System Cumulative Counters  
A cumulative counter monitors the appropriate items that had been handled by the system since last 

counters reset. 

Name Description Supplementary Explanation 

Total Incoming Calls  The total number of incoming calls being handled by 
the system since last counters reset 

(Incoming ACD Calls) + 
(Incoming Non ACD Calls) 

Incoming ACD Calls  The total number of ACD calls being handled by the 
system since last counters reset 

System Active (Current ACD 
Calls) 

Incoming Non ACD 
Calls  

The total number of Non ACD calls being handled by 
the system since last counters reset 

Total number of calls to Agents 
via CO 

Total Answered 
Calls  

The total number of answered calls (ACD and Non 
ACD) being handled by the system since last 
counters reset 

(Answered ACD Calls) + 
(Answered Non ACD Calls) 
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Name Description Supplementary Explanation 

counters reset 

Answered ACD 
Calls  

The total number of answered ACD calls being 
handled by the system since last counters reset 

Group Cumulative (Answered 
Direct ACD Calls) 

Answered Non ACD 
Calls  

The total number of answered Non ACD calls being 
handled by the system since last counters reset 

 

Lost ACD Calls  The total number of lost ACD calls handled by the 
system since last counters reset 

Queue Cumulative (Lost ACD 
Queued Calls) + Group 
Cumulative (Total Lost ACD 
Calls) 

Total Abandoned 
System Calls  

The total number of calls that were dropped before 
the Threshold Time expired, since last counters reset 

Group Cumulative (Total 
Abandoned Calls) + Agent 
Cumulative (Abandoned Calls to 
Agent) 

Outgoing Calls  The total number of outgoing calls being handled by 
the system since last counters reset 

Agent Cumulative (Outgoing 
Calls by Agent) 

Lost ACD Calls (%)  The percentage of lost ACD calls since last counters 
reset 

[(Lost ACD Calls)  * 100 / 
(Incoming ACD Calls)] 

 

ACD System Peak Counters  
A peak counter displays the highest value reached by that counter since last counters reset. 

Name Description Supplementary Explanation 

Peak Incoming Calls  The peak number of incoming calls since last 
counters reset 

Peak value of (Total Incoming 
Calls) 

Peak Incoming ACD 
Calls  

The peak number of ACD calls since last counters 
reset 

Peak value of (Incoming ACD 
Calls)  

Peak Incoming Non 
ACD Calls  

The peak number of Non ACD calls since last 
counters reset 

Peak value of (Incoming Non 
ACD Calls)  

Peak Waiting ACD 
Calls  

The peak number of waiting ACD calls since last 
counters reset 

Peak value of (Waiting ACD 
Calls)  

Peak Calls In Queue  The peak number of ACD calls waiting in Queue 
since last counters reset 

Peak value of (Waiting ACD 
Calls In Queue)  
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Queue 

NOTE: The calls received at a group can be counted. 

Queue Active Counters 
An active counter monitors the appropriate items that are being handled by the system at that very moment. 

Name Description Supplementary Explanation 

ACD Calls In Queue The total number of ACD calls that are currently 
waiting in Queue 

Group Active (Current ACD 
Queued Calls) 

Queue Cumulative Counters  
A cumulative counter monitors the appropriate items that had been handled by the system since last 

counters reset. 

Name Description Supplementary Explanation 

ACD Calls In Queue  The total number of ACD calls that waited in Queue 
since last counters reset 

System Cumulative (Incoming 
ACD Calls) 

Queued Calls to 
Overflow 
destination  

The total number of calls in Queue that were 
transferred to the Overflow destination since last 
counters reset 

Group Cumulative (Overflowed 
ACD Calls) 

Lost ACD Queued 
Calls  

The total number of calls that were lost while waiting 
in Queue since last counters reset 

Group Cumulative (Total ACD 
Calls Lost In Queue) 

Abandoned Queued 
Calls  

The total number of calls dropped, before Threshold 
Time expired, while waiting in Queue since last 
counters reset 

Increments at every call that 
exits the system while is waiting 
in queue (before the threshold 
time expires) 

Queue Peak Counters  
A peak counter displays the peak value reached by that counter since last counters reset. 

Name Description Supplementary Explanation 

Peak ACD Calls In 
Queue  

The peak number of ACD calls that were waiting in 
Queue since last counters reset 

Peak value of (Waiting ACD 
Calls In Queue) 
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Group 

Group Active Counters 
An active counter monitors the appropriate items that are being handled by the system at that very moment. 

Name Description Supplementary Explanation 

Current Incoming 
ACD Calls 

The number of ACD calls currently being handled by 
the group 

The call to ICD Group via CO 

The call from internal extension 
to ICD Group 

 

Current Direct ACD 
Calls  

The number of direct ACD calls currently being 
handled by the group 

 

Current Redirected 
ACD Calls  
(Overflowed)*  

The number of calls overflowed from another group 
and currently being handled by this group  

 

Current Redirected 
ACD Calls  (Not 
answered)  

The number of calls transferred (Not answered) from 
another group and currently being handled by this 
group 

 

Incoming Waiting 
ACD Calls  

The number of ACD calls that are currently waiting for 
an answer (ringing and in queue) 

 

Current ACD 
Queued Calls  

The number of ACD calls that are currently waiting in 
the Queue 

 

Current Answered 
ACD Calls  

The number of active direct answered ACD calls  

Outgoing Calls  The number of outgoing calls that are currently being 
handled by agent in this group 

 

Log In Agents  The total number of Agents that are currently logged-
in to the group 

(Log In Agents (Active: Idle)) + 
(Log In Agents (Active: Busy)) + 
(Log In Agents (Active: Wrap-
up)) + (Log In Agents ( Break)) 

Log In Agents 
(Active: Idle) 

The number of Agents that are currently logged-in 
and are in the idle status 

Increments every time a logged 
in agent becomes idle (after a 
break, Busy or any other state) 
and decrements every time the 
Agent changes the idle state into 
another. 

Log In Agents 
(Active: Busy)  

The number of Agents that are currently logged-in are 
in the busy status 

(Log In Agents) - (Log In Agents 
(Active: Idle)) - (Log In Agents 
(Active: Wrap-up)) - (Log In 
Agents (Break)) 

Log In Agents 
(Active: Wrap-up)  

The number of Agents that are currently logged-in 
and are in the wrap-up status 

(Log In Agents) - (Log In Agents 
(Active: Idle)) - (Log In Agents 
(Active: Busy)) - (Log In Agents 
(Break)) 

Log In Agents 
(Break)  

The number of Agents that are currently logged-in 
and are in the break status 

(Log In Agents) - (Log In Agents 
(Active: Idle)) - (Log In Agents 
(Active: Busy)) - (Log In Agents 
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Name Description Supplementary Explanation 

(Active: Wrap-up)) 

Log Out Agents  The number of Agents that are currently logged–out  Increments every time an agent 
logs out and decrements every 
time an agent logs in (from this 
group). 

* Busy Overflow is not counted 

Group Cumulative Counters  
A cumulative counter monitors the appropriate items that had been handled by the system since last 

counters reset. 

Name Description Supplementary Explanation 

Total Incoming ACD 
Calls  

The total number of ACD calls handled by the group 
since last counters reset 

 

Total Redirected 
ACD Calls  
(Overflowed)*  

The total number of calls overflowed from another 
group and handled by this group since last counters 
reset 

Increments every time when an 
overflowed call is delivered to the 
group (the group is the Overflow 
No Answer Destination) 

Total Redirected 
ACD Calls  (Not 
answered)  

The total number of calls transferred (Not answered) 
from another group and handled by this group since 
last counters reset 

Increments every time when an 
unanswered call is delivered to 
the group (the group is the 
Overflow No Answer Destination) 

Total Incoming Non 
ACD Calls  

The total number of Non ACD calls handled by the 
group since last counters reset 

 

Total Incoming 
Redirected ACD 
Calls 

The total number of incoming redirected ACD calls 
handled by the group since last counters reset 

(Total Redirected ACD Calls  
(Overflowed)) + (Total 
Redirected ACD Calls  (Not 
answered)) 

Not Answered ACD 
Calls 

The total number of ACD calls redirected to No 
Answer destination since last counters reset 

Agent cumulative (ACD Calls Not 
Answered by Agent) 

Overflowed ACD 
Calls  

The total number of ACD calls redirected to overflow 
destination since last counters reset 

Increments every time when a 
call is delivered to the Overflow 
Destination because the group 
was busy. 

Answered Direct 
ACD Calls  

The total number of direct answered ACD calls 
handled by the group since last counters reset 

Agent Cumulative (Total 
Answered ACD Calls) 

Total Lost ACD 
Calls  

The total number of ACD calls lost by the group since 
last counters reset 

(Total ACD Calls Lost In Queue) 
+ (Total ACD Calls Lost by 
Agents) 

Total ACD Calls 
Lost In Queue 

The total number of ACD calls lost in Queue since 
last counters reset 

(Total Lost ACD Calls) – (Total 
ACD Calls Lost by Agents) 

Total ACD Calls 
Lost by Agents  

The total number of ACD calls lost (not answered) by 
Agents since last counters reset  

Agent Cumulative (Total ACD 
Calls Lost by Agent) 

Total Abandoned 
Calls 

The total number of calls that were dropped before 
the Threshold Time expired, since last counters reset 

Increments for every abandoned 
ACD call 
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Name Description Supplementary Explanation 

Not Answered ACD 
Calls (%) 

The percentage of ACD calls redirected to No Answer 
destination since last counters reset 

(Not Answered ACD Calls)*100/ 
(Total Incoming ACD Calls) 

Overflowed ACD 
Calls (%)  

The percentage of ACD calls redirected to overflow 
destination since last counters reset 

(Overflowed ACD Calls) * 100 / 
(Total Incoming ACD Calls) 

Lost ACD Calls (%)  The percentage of lost ACD calls by that group since 
last counters reset 

 

ACD Calls Lost In 
Queue (%)  

The percentage of lost ACD calls while waiting in 
Queue since last counters reset 

(Total ACD Calls Lost In Queue) 
* 100 / (Total Lost ACD Calls) 

* Busy Overflow is not counted 

Group Peak Counters  
A peak counter displays the highest value reached by that counter since last counters reset. 

Name Description Supplementary Explanation 

Peak Incoming ACD 
Calls  

The peak number of ACD calls since last counters 
reset 

Peak value of (Current Incoming 
ACD Calls)  

Peak Incoming 
Direct ACD Calls  

The peak number of direct ACD calls since last 
counters reset 

Peak value of (Current Direct 
ACD Calls) 

Peak Redirected 
ACD Calls  
(Overflowed)  

The peak number of redirected ACD calls since last 
counters reset (Overflowed) 

Peak value of (Current 
Redirected ACD Calls  
(Overflowed)) 

Peak Redirected 
ACD Calls  (Not 
answered) 

The peak number of redirected ACD calls since last 
counters reset (Not answered) 

Peak value of (Current 
Redirected ACD Calls  (Not 
answered)) 

Peak ACD Calls In 
Queue  

The peak number of ACD calls waiting in Queue 
since last counters reset 

Peak value of (Current ACD 
Queued Calls) 

Agent 

Agent Active Counters  
An active counter monitors the appropriate items that are being handled by the system at that very moment. 

Name Description 

Total Incoming Calls  The number of ACD calls currently being handled by the Agents  

Agent Cumulative Counters  
A cumulative counter monitors the appropriate items that had been handled by the system since the 

beginning of the login session. 

Name Description Supplementary Explanation 

Total Incoming Calls The total number of incoming calls handled by the 
Agent since last counters reset 

(Total Incoming ACD Calls) + 
(Total Incoming Non ACD Calls) 
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Name Description Supplementary Explanation 

Total Incoming ACD 
Calls  

The total number of ACD calls handled by the Agent 
since last counters reset 

(Total Incoming Direct ACD 
Calls) + (Total Redirected ACD 
Calls  (Overflowed)) + (Total 
Redirected ACD Calls  (Not 
answered)) 

Total Incoming 
Direct ACD Calls  

The total number of direct ACD calls handled by the 
Agent since last counters reset 

(Total Incoming ACD Calls) - 
(Total Redirected ACD Calls  
(Overflowed)) - (Total Redirected 
ACD Calls  (Not answered)) 

Total Incoming Non 
ACD Calls 

The total number of Non ACD calls handled by the 
Agent since last counters reset 

Increments when a Non ACD call 
arrives at the monitored agent.  

Total Redirected 
ACD Calls  
(Overflowed) 

The total number of calls overflowed from another 
group and handled by this Agent since last counters 
reset 

Increments every time when an 
overflowed call is delivered to the 
Agent (the Agent is the Overflow 
No Answer Destination)  

Total Redirected 
ACD Calls  (Not 
answered) 

The total number of calls transferred (Not answered) 
from another group and handled by this Agent since 
last counters reset 

Increments every time when an 
unanswered call is delivered to 
the Agent (the Agent is the 
Overflow No Answer Destination) 

Total Answered 
Calls  

The total number of calls answered by the Agent 
since last counters reset 

(Total Answered ACD Calls) + 
(Total Answered Non ACD Calls) 

Total Answered 
ACD Calls  

The total number of Non ACD calls answered by the 
Agent since last counters reset 

Increments when an ACD call 
arrives in the Agent and is 
answered by the monitored 
agent. 

Total Answered Non 
ACD Calls  

The total number of ACD calls answered by the 
Agent since last counters reset 

Increments when a Non ACD call 
arrives in the Agent and is 
answered by the monitored 
agent. 

Total ACD Calls 
Lost by Agent  

The total number of ACD calls lost (Not answered) by 
the Agent since last counters reset 

Increments when a call arrives at 
the Agent and is not answered. 
Doesn't increment when a call 
dropped before the Abandoned 
Call Threshold Time in Basic 
Settings expired. 

Abandoned Calls to 
Agent  

The total number of ACD calls lost (call dropped 
before the Threshold Time expired) by the Agent 
since last counters reset. 

This counter increments its value 
every time a call arrives at the 
Agent and is hanged-up before 
being answered before the 
threshold time expires. 

Outgoing Calls by 
Agent 

The number of outgoing calls originated by Agent This counter increments its value 
every time the Agent performs an 
outgoing call. 

ACD Calls Not 
Answered by Agent 

The number of calls Not answered (transferred to the 
No Answer destination) since last counters reset 

This counter increments its value 
every time a call is not answered 
by the Agent and the call was 
delivered to the No Answer 
destination 

ACD Calls Not 
Answered by Agent 
(%) 

The percentage of calls Not answered (transferred to 
the No Answer destination) since last counters reset 

(ACD Calls Not Answered by 
Agent) * 100 / (Total Incoming 
ACD Calls) 
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Name Description Supplementary Explanation 

(%) ACD Calls) 

Total Answered 
Calls (%)  

The percentage of calls answered by the Agent since 
last counters reset 

(Total Answered Calls) * 100 / 
(Total Incoming Calls) 

Lost ACD Calls by 
Agent (%) 

The percentage of ACD calls lost by the Agent since 
last counters reset 

(Total ACD Calls Lost by 
Agent)*100/ (Total Incoming 
ACD Calls) 

Agent Active Timers 
An active timer monitors the appropriate items that are being handled by the system at that very moment. 

Name Description Supplementary Explanation 

Agent Log In Time 
Period 

The Agent logged-in time period (Idle Time) + (Break Time) + 
(Wrap-up Time) + (Busy Time) 

Agent Cumulative Timers 
A cumulative timer monitors the appropriate items that had been handled by the system since last counters 

reset. 

Name Description 

Idle Time The total Agent time in the Idle status since last counters reset 

Break Time 
 

The total Agent time in the break status since last counters reset 

Wrap-up Time The total Agent time in the Wrap-up status since last counters reset 

Busy Time The total Agent time in the Busy status since last counters reset 

Idle Time (%) The percentage of Agent time in the Idle status since last counters reset 

Busy Time (%) The percentage of Agent time in the Busy status since last counters reset 

Wrap-up Time (%) The percentage of Agent time in the Wrap-up status since last counters reset 

Break Time (%) The percentage of Agent time in the Break status since last counters reset 

Agent Average Waiting 
Time for ACD Calls  

The average time the ACD calls waited for an Agent answer since last counters 
reset 

Agent Average Talk Time 
for ACD Calls 

The average Agent talk time for ACD calls since last counters reset 

Agent Average Hold Time 
for Incoming Calls 

The average Agent hold time for incoming calls since last counters reset 

Agent Average Hold Time 
for ACD Calls 

The average Agent hold time for ACD calls since last counters reset 
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Name Description 

Agent Average Talk Time 
for Outgoing Calls 

The average Agent talk time for outgoing calls since last counters reset 

Agent Average Hold Time 
for Outgoing Calls 

The average Agent hold time for outgoing calls since last counters reset 

Agent Longest Waiting 
Time for ACD Calls 

The longest time the ACD calls waited for an Agent answer since last counters 
reset 

Agent Longest Talk Time 
for ACD Calls 

The longest Agent talk time for an ACD call since last counters reset 

Agent Longest Hold Time 
for ACD Calls 

The longest Agent hold time for an ACD call since last counters reset 

Agent Longest Talk Time 
for Outgoing Calls 

The longest Agent talk time for an outgoing call since last counters reset 

Agent Longest Hold Time 
for Outgoing Calls 

The longest Agent hold time for an outgoing call since last counters reset 

Call 

Call Active Timers 
An active timer monitors the appropriate items that are being handled by the system at that very moment. 

Name Description 

Call Duration The duration of the call since the call reach the system (Call type is displayed) 

Call Time The duration of the call in current status (the call status is displayed) 

Call Cumulative Timers 
A cumulative timer monitors the appropriate items that had been handled by the system since last counters 

reset. 

Name Description 

Total Waiting Time for 
ACD Call 

The waiting time for this ACD call  

Waiting Time for ACD Call 
In Queue 

The waiting time for an ACD call in the Queue  

Waiting Time for ACD Call 
at Agent 

The waiting time for an ACD call for an Agent answer  

Talk Time for ACD Call The talk time for this ACD call  

Hold Time for ACD Call The hold time for this ACD call  

Talk Time for Outgoing 
Call 

The talk time for this outgoing call  
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Name Description 

Hold Time for Outgoing 
Call 

The hold time for this outgoing call  
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Glossary of Terms 
 Abandoned Call – an incoming call that exits the system before the Abandoned Call Threshold Time in 

Basic Setting expires 

 ACD – Automatic Call Distribution – a telephone facility used for handling many incoming calls. The 

ACD will recognize and answer an incoming call, will look in its database for call routing instructions, it 

will send the call to a recording or IVR or will send the call to an available Agent according to the 

instructions for that call 

 ACD Call – the incoming calls that arrive at the call center directly.  

 ACD Queue – is where the calls first arrive when they enter the call center and wait to be served by an 

Agent. The calls in the ACD Queue will be distributed to the available Agents according to the pre-

programmed distribution patterns 

 Agent – each person assigned to one or more specific Group. In this document this term is referred to 

as Agent 

 Agent Status – the current state mode of the Agent such as Busy, Idle, etc. 

 ANI – Automatic Number Identification – a service that provides the receiver of a telephone call with the 

number of the calling phone 

 Break – an Agent state that indicates that the Agent is in break and is unavailable to take calls (Not 

Available) 

 Busy – an Agent state that indicates that the Agent is unavailable to take calls 

 Caller ID – a telephone network feature that passes the number of the phone the caller is using to the 

call center, real-time 

 CO – Central Office – the phone company that a local phone or phone system is connected to 

 Customer – a calling party of incoming calls.  

 DDI/DID/MSN – Direct Dial In/Direct Inward Dialing/Multiple Subscriber Numbers – a service of a local 

phone company that provides a block of telephone members for calling into a company's private branch 

exchange (PBX) system 

 DNIS – Dialed Number Identification Service – a telephone service that identifies for the receiver of a 

call the number that the caller dialed 

 Group – a collection of Agents that share a common set of skills, such as being able to handle 

customer complaints. In this document this term is referred to as ACD Group or Group 

 Idle – an Agent state that indicates that the Agent is available to take calls 

 Incoming call – a telephone call that was originated by a party remote from the local switch and that is 

directed toward a party on the switch 

 Lost call – a call hung up by the calling party while ranging at Agent 
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 Monitoring – a system capability that enables a supervisor or manager to remotely monitor the Agents 

activity 

 No Answer ACD Call – ACD call that was redirected from an agent of the group to other destination 

after a specific timeout 

 Non ACD Call – CO incoming calls delivered directly to extensions with no ICD PBX algorithm 

involvement. Conference and transferred calls are also included in this category. 

 Direct ACD Call – incoming ACD call that was not delivered to group due to overflow or no answer 

situation 

 Outgoing call – a telephone call that was originated by a party associated with the local switch and that 

is directed toward a remote party 

 Overflow ACD Call – ACD call that was redirected from the group queue to other destination after a 

specific timeout 

 Reports – reports that track call center and agent performance over a period of time 

 Threshold – the point at which an action, change or process takes place 

 Trunk – a telephone circuit linking two switching systems. The CO line used to process a call. 

 Wrap-up time – a period of time (in seconds) required by an Agent after a conversation is ended, to 

complete work that is directly associated with the call just completed. During wrap-up time no call will be 

distributed to the Agent  
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Troubleshooting  

Error messages and solutions 

Error Message Possible cause (bold) and solution 

PBX is in initializing state The PBX was restarted while the KX-NCV200 ACD Report Server 

was connected. Wait for the PBX to initialize.  

PBX is in disconnected state Check if the PBX is running, if the PBX is connected to the local 

network, and if the IP address is correct. 

Server is in disconnected 

state 
Check the KX-NCV200 ACD Report Server state and check the 

connection of the Client with the Server 

Server HDD has reached the 

maximum limit. Server 

started to delete old data. 

The Database maximum size is 15GB. The Server starts deleting the 

data starting with the oldest one. To save the database, perform the 

Backup Client Database operation. 

Cannot connect to server. 

Maximum number of clients 

reached 

The maximum number of Clients that can be connected simultaneously 

to the Server is 3. Check the number of Clients that are connected to the 

Server. 

Invalid restore folder When performing the Restore database operation make sure to select 

the path where you have previously saved the information. 

Server restarted in order to 

connect to new PBX. This 

client will close. 

When changing the PBX settings the KX-NCV200 ACD Report must be 

restarted. 

NCV Configuration was 

changed other clients and 

this requires application 

restart. This client will close. 

When changing the KX-NCV200 ACD Report configuration (from Agent 

Mode to Extension Mode or from Extension Mode to Agent Mode) the 

application must be restarted. 
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Error Message Possible cause (bold) and solution 

Cannot run performance 

viewer when server is not 

connected to PBX 

The Performance Graphs section cannot be viewed if the KX-NCV200 

ACD Report is not connected to PBX. Connect the KX-NCV200 ACD 

Report to PBX. 

Please select an option: 

print, export or send mail. 

Before you can add a report to schedule, you must select a schedule 

option: print, export or send mail 

Maximum number of 

schedules have been 

reached. 

The maximum number of reports that can be scheduled is 21. 

Not allowed report for 

Extension Mode 

configuration! 

The Agent ID based Report can only be generated if KX-NCV200 ACD 

Report is in Agent Mode. 

Cannot add agent based id 

report schedule because 

you are in extension mode. 

The Agent ID based Report can only be generated if KX-NCV200 ACD 

Report is in Agent Mode. 

 

Error 10054 when updating 

server. 

You need to restart the Server. You can use the Restart button from the 

Configuration section or turn OFF and then ON the KX-NCV200. 

No data to display according 

with current filtering criteria. 

Please check filtering 

criteria 

No records match the chosen filtering criteria, please check the 

chosen filtering criteria or there are no records in the database for the 

selected report type.  

Possible Problems 

Problem Possible cause (bold) and solution 

The beginning of Agent ID or 

Password disappears when 

exported Agent Data file is 

edited with Microsoft Excel 

and then imported. 

In case the beginning of Agent ID or Password is”0”, it is deleted 

when the file is edited with Microsoft Excel. Add “0” manually to the 

beginning of Agent ID or Password. 

It takes a long time for the 

Client to start. 

The numerous call information stored on the Server can cause 

delays (several minutes or several hours) when starting the Client 

application. 
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Problem Possible cause (bold) and solution 

Server was updated and the 

ACD tree shows duplicated 

groups. 

When you reopen the Client from the Server Location window choose 

the “Clear Client Database” option. If the problem persists, please 

uninstall and reinstall the Client application. 

Monitoring can not be 

activated in case of Overflow 

queuing busy. 

Overflow queuing busy is not supported. Calls related to Overflow 

queuing busy can not be monitored. 

 If you change a group name in the PBX you will loose counters values and settings for that group. Also 

on the filters you will get the old group name data in ACD Reports and Call Log and Agent Log when 

you select new group name. 

 When the ACD Report Server is in Extension Mode, if you change the extension name in the PBX you 

will loose counters values and settings for that extension. Also on the filters you will get the old 

extension name data in ACD Reports and Call Log and Agent Log when you select new extension 

name. 

 Please add new groups inside the TDA Maintenance Console at the end of the groups list. Otherwise 

filtering by groups will not work correctly. 

 If an extension is logged out by the group supervisor while it has an active call then that call might not 

be cleared from the ACD tree. That extension will appear as idle, but with an active call in talking state. 

To remove the call, the ACD Report Server must be restarted. 

 In the following scenario (using a SLT phone), the call is not cleared from the ACD tree: 

1. Answer an incoming call and put it on hold (flash-hook). 

2. Make an outgoing call  

3. Flash hook + 3 to start a conference 

4. Flash hook to end the conference and start talking with outgoing 

5. Hang – up. 

Result: After hanging up, the incoming call is not cleared. To remove the call, the ACD Report 

Server must be restarted. 

 If the Extension No Answer Time is equal with the Overflow Time the call is not cleared from ACD tree. 

To remove the call, the ACD Report Server must be restarted. 

 Call information is accumulated in Server even though no Client is connecting to Server. When a Client 

connects to Server, the Client will receive all call information, which it has not received yet from Server. 

After the Client completes receiving the call information, its starting process will be finished. And the 

Client application will be ready for users to use. Due to this reason, at the following cases, it will take 

long time to start Client because there will be a lot of call information that Client has to receive. 

 When Client has not connected to Server for long time. 

 When the large amount of calls is on PBX even though it has not been so long time since Client 

connected to Server last time. 
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To make Client start faster, it is highly recommended that Client connects to Server often, or Client 

keeps connecting to Server during the term, which the amount of calls is large in of a day. 

 When a Client connects to Server, if the Client has not connected to Server for more than 2 days, the 

Client will receive call information which is older than last 2 days from Server even after the Client 

opens. Due to this mechanism, it takes time to receive all call information and display the entire call 

history or create reports with entire call information. So when NCV200 is used in the environment that a 

large amount of calls are, it is highly recommended that Client is connecting to Server all the time or 

Client connects to Server short periodically. 

The Agent Data fields limitations 

Field Limitation 

Agent Name Maximum 20 characters 

Agent ID 4 digits (0000-9998) 

Password 4 digits (0000-9999) 

The tips 
When creating an Agent Report or an Agent ID based Report a tip window is displayed 

 

 If you do not wish to show this tip again you can choose the Do not show this tip again option 

 The tips can be enabled from the main menu Help> Enable all tips 
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Export/Import Data explanations 

The exported .csv file contains only the visible fields in their displaying order. See the 
table bellow with all columns and fields explanation (with the fields in the default order) 

Customer Data  

Exporting the Customer Data into a .csv file, which contains the following fields: 

Excel Column Field Name Field Description 

A First Name Customer first name 

B Middle Name Customer middle name 

C Last Name Customer last name 

D Caller Name Only if it is received from the CO 

E Caller ID The customer phone number 

When importing information into the Customer Data, you have to respect the following limitations: 

Field Name Field Description 

First Name Maximum 30 characters 

Middle Name Maximum 18 characters 

Last Name Maximum 30 characters 

Caller Name Maximum 32 digits (0-9) 

Caller ID Maximum 32 digits (0-9) 

Agent Data 

Exporting the Agent Data creates a .csv file, which contains the following fields: 

Excel Column Field Name Field Description 

A Agent Name Agent Name 

B Agent ID Agent ID 

C Agent Password Agent Password 

When importing information into the Agent Data, you have to respect the following limitations: 

Field Name Field Description 

Agent Name Maximum 20 characters 

Agent ID 4 digits (0-9) 

Agent Password 4 digits (0-9) 
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Call Log – CO Based 

Exporting the Call Log – CO Based creates a .csv file, which contains the following fields: 

Excel Column Field Name Field Description 

A Call Log ID Every call the system handles receives an ID 
number 

B Date/Time Displays the date and time the call arrived in 
the ACD Queue or the Agent 

C Completion Time The time the call was completed 

D Customer Displays the full customer name (First, Middle 
and Last) 

E 

 

Caller ID The customer phone number 

F Caller Name Available only if it is received from the CO 

G Incoming/Outgoing Type of call 

H Status Displays the call status 

I Dialed Number The number the customer dialed 

J DDI/DID/MSN The DDI/DID/MSN data (number) from the 
public exchange (CO) 

K DNIS Dialed Number Identification Service 

 

L ANI Automatic Number Identification 

M Trunk CO line number used for that call 

N Talk Time The length of time the call was in conversation 
with Agents 

O Wait Time The length of time the call waited in the ACD 
Queue and rang at Agent (Queue Time + Ring 
Time) 

 

P Hold Time The total time a call was placed on hold by the 
Agent 

Q Ring Time The length of time the Agent extension has 
rang while the call has been left unanswered 

 

R Queue Time The period of time spent waiting in the ACD 
Queue 

S Call Duration The total time spent in the system from the 
moment the call entered until it exits the 
system 
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Excel Column Field Name Field Description 

T Number of Overflowed The number of times the call was transferred 
because of overflow. Overflow Queuing Busy 
is not supported. 

U Number of No Answered 
 

The number of times the call wasn't answered 

V Number of Transferred The number of times the call one Agent 
transferred the call to another extension 
(Agent) or ICD Group 

W Number of Conference A conference is a call with at least 3 
participants. Number of Conference increases 
every time when a call changes from 2 to 3 
participants. 

Call Log – Agent Based 

Exporting the Call Log – Agent Based creates a .csv file, which contains the following fields: 

Excel Column Field Name Field Description 

A Call Log ID Every call the system handles receives an ID 
number 

B Date/Time Displays the date and time the call arrived in 
the ACD Queue or the Agent 

C Completion Time The time the call was completed 

D Agent Name Only if it is received from the CO 

E 

 

Group Name The customer phone number 

F Extension The extension number 

G Customer Displays the full customer name (First, Middle 
and Last) 

 

H Caller ID The customer phone number 

I Caller Name Available only if it is received from the CO 

J Trunk CO line number used for that call 

K Dialed Number The number the customer dialed 

L DDI/DID/MSN The DDI/DID/MSN data (number) from the 
public exchange (CO) 

M DNIS Dialed Number Identification Service 

 

N ANI Automatic Number Identification 

 

O Incoming/Outgoing Type of call 
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Excel Column Field Name Field Description 

P Call Status Displays the call status 

Q Talk Time The length of time the call was in conversation 
with Agents 

R Wait Time The total time that the call waits until it is 
answered  (speed of answer) 

S Hold Time The total time a call was placed on hold by the 
Agent 

T Queue Time The period of time spent waiting in the ACD 
Queue 

U Ring Time The length of time the Agent extension has 
rang while the call has been left unanswered 

V Call Duration The total time spent in the system from the 
moment the call entered until it exits the 
system 

W Transferred Yes/No 

X No Answer Yes/No 

Y Conference Yes/No 

Z Group Overflowed From Only if the call overflowed from another ACD 
Group 

AA Agent No Answer From Only in case that the call wasn’t answered by 
the Agent it was delivered to, and it was 
transferred to the No Answer Destination 

AB Extension No Answer From The extension number of the Agent the call 
was transferred from in case of No Answer 

 

AC Agent Transferred From The name of the Agent that transferred the call 

AD Extension Transferred From The extension number of the Agent that made 
the transfer 

AE Agent Transferred To The name of the Agent the call was transferred 
to 

AF Extension/Dialed Number 
Transferred To 

The extension or the dialed number the call 
was transferred to 
 

AG Extension/Dialed Number 
Conference 

The extension or the dialed number for the 
conference 

AH Agent ID The Agent ID number 
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Agent Log 

Exporting the Agent Log creates a .csv file, which contains the following fields: 

Excel Column Field Name Field Description 

A Login Date/Time Agent Login Date and Time 

B Logout Date/Time Agent Logout Date and Time 

C Agent Name Agent Name 

D Group Name Group Name 

E 
 

Extension The extension number 

F Login Duration The total length of time the Agent was logged 
in 

G Break Time The total length of time the Agent was in the 
Break 

H Busy Time The total length of time the Agent was Busy 

I Idle Time The total length of time the Agent was Idle 

J Wrapup Time The total time spent by the Agent on wrapup 
activities 

K Total Incoming ACD Calls The total number of ACD calls delivered to the 
Agent 

L Total Incoming Non ACD Calls The total number of Non ACD calls delivered 
to the Agent 

M Total Answered Non ACD Calls  The total number of Non ACD calls answered 
by the Agent 

N Total Incoming Calls The total number of calls delivered to the 
Agent 

O Total Lost Calls The total number of calls hung up by the 
calling party before the Agent to answer 

P Total Answered Calls The total number of calls answered by the 
Agent 

Q Agent ID The Agent ID number (available for the NCV 
Agent mode) 
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